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Introduction

The Geomar RTmap31 Data Logging System consists of a data logging program RTmap31 and
associated PC computer program RTM31. The program RTmap31 is designed for the Windows
CE based Allegro CX field computer.

The program RTM31 is used to process data files recorded under the control of program RT-
map31. It recognizes data file formats created with various versions of RTmap31 automatically.

1.1 About the RTM31

The program RTM31 is a Windows based program for IBM PC compatible comput-

ers operating under MS Windows 10/7/XP and Windows 2000. The program RTM31 is
designed to process data collected by a field computer under the control of programs
RTmap31. The program can be used to position EM31-MK?2 sensor based on real time
GPS data or by using a postprocessed GPS file. The program allows you also to convert
data to Geonics DAT38MK?2 format, to convert to ASCII text file format, to position
field comments, generate position file for stand-alone GPS positions (GXY), and to cor-
rect created XYZ files for a delay (latency) caused by the system time constant.

Main function of this program is to position Geonics EM31-MK2 based on the recorded
GPS position, the instant heading of the system, the configuration of the system, and
several user specified filters. Configuration of the system is described by offsets of the
GPS antenna from the center of the EM31-MK2 sensor. The program calculates real
position of the instrument based on specified GPS antenna offset and direction of the
movement. However, it is highly recommended that GPS antenna is placed in the center
of the EM31-MK2 sensor as this configuration provides the best accuracy. Optionally
elevation data can be written to the output file. The program corrects elevation data for
the GPS antenna height. The program can process seven different NMEA GPS mes-
sages recorded by data acquisition software RTmap31: a pair GGA/GSA, GGA, POS,
LLK, LLQ, GLL, and GGK (Trimble and Leica versions). In addition program handles
interface of Leica Robotics Total Station TPS1100 and TPS1200.

The RTM31 also allows you to correct the collected GPS positions with post-processed
GPS files.

1.
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The RTM31 uses data files in RTmap31 format which have extension name T31. These
are binary files with a record length of 27 bytes terminated by Line Feed character.
These files should not be edited using standard text editors. The program can also
process files with extension GXY. The GXY file contains stand-alone GPS positions if
the RTmap31 program was used to collect GPS data only. These files are also binary (re-
cords are 27 bytes for Windows CE based program and terminated by Line Feed charac-
ter) and care should be taken if they are viewed with text editors. Files GXY generated
by any other Geomar data acquisition program i.e. ML61, NAV61, NAV31, etc. are fully
compatible and they can be processed by RTM31.

One sample RTmap31 data file, 031722B.T31, and one external (postprocessed) GPS
file Trext04.txt are included on the program disk. They allow the user to become famil-
iar with running the RTM31 program.

1.2 Contents of RTM31 Distribution Disk

Program RTmap31 software is supplied on one CD disk or USB memory stick. Disk
contains following files and directories:

Setup31R - setup program for RTM31

SetupRTmap31 - installation for data acquisition program RTmap31 Win-
dows 10 version (can be also RT'map31wm for Windows
Mobile version)

RTM31.pdf - manual for RTM31 in pdf format
RTmap31l.pdf - manual for data acquisition program RTmap31
Documentation - directory containing all RT'map31 and RTM31 available

RTmap31 manuals, and other Geomar manuals in PDF
format.

The Software can be supplied on a CD disk or USB memory stick, or by download from
provided link. While downloading files are often named showing their version number,
for example Setup31R.exe can be posted as Setup31R_V117.exe to indicate that the
setup program contains program RTM31 version 1.17.
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1.3 RTM31 Software Installation

RTmap31 software uses a setup program to load files necessary for data processing

onto your computer. The following section describes the installation process. To install
RTM31: Insert the RTmap31 CD disk or USB stick into computer CD drive (or USB
memory drive to USB connector). Alternatively use the SetpRTM31R file in Windows
Explorer if the software was downloaded. Exit all Windows applications before installing
the program. From the Windows File Manager, select Run from the Windows System
menu (or simply press key Windows + R). The Run dialog box opens (Figure 1.1).

= Type the name of a program, folder, decument, or Internet
1= resource, and Windows will open it for you,

Open: D:\Setup31R.exe w

Cancel Browse...

Figure 1.1:  Run Dialog window

Alternatively, browse for the file SetupR.exe in the CD disk, USB disk, or Windows
folder. Double click OK to launch the Setup program. Once the Setup determines your
computer configuration the Welcome window opens (Figure 1.2).

0o RTM31 Setup

Geomar Software Inc.
‘Welcome to the installer for RTM31 V1.17.

It is strongly recommended that you exit all Windows programs
before continuing with this installation.

If you have any other programs running, please click Cancel,
closze the programs, and run this setup again.

Otherwise, click Next to continue

Cancel

Figure 1.2:  Welcome window

Read the text and click the Next button. The License Agreement window will be dis-
played (Figure 1.3).
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B0 RTM31 Setup

Tems And Conditions ~
Thig program is provided "AS 15", Geomar Software Inc. is NOT responsible for any damage

(or damages) attibuted to RTM31 or its field component RTmap31 {or equivalent

RTmap31wm and RTmap31wg). You are wamed that you use the program at your own rigk.

Mo warranties are implied or given by Geomar Software or any representative

This license cannot be sold or donated to a thind person or company

Uzage

This package is a single user license only. The software can be installed on multiple
computers. While the associated data acquisition program RTmap31 frequires Software Key)
can be used on one field computer only at any time the data processing program RTM31 can
be used on three computers simultaneously within the organization that owne the license.

(@) | agree to the tems of this license agreement

() | do not agree to the terms of this license agreement

[ <Baek || ﬂaﬁ>$| Caneel

Figure 1.3: License Agreement window

Read the text and click the Next button. The Serial Number window will be displayed
(Figure 1.4).

o RTM31 Setup

er your serial number and click Next to continue.

Serial number is case sensitive, please use LUPPER CASE for non numeric characters
Serial Number:

e [ ) | G

Figure 1.4:  Serial Number window

Type the Serial Number into the provided box and press the Next button. (If you do not
know the Serial Number, you will not be able to continue.) The Installation Directory
window opens (Figure 1.5).
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The default directory is C:\Program Files\RTM31. Click the Next button to install the
program to this directory. If you wish to install RTM31 to another directory, click the
Change button, and the Select Installation Directory window will open. Select a target
directory and click OK. The Select Installation Directory window closes, and the Instal-
lation Directory window opens with the selected directory listed. Click the Next button.

B0 RTM31 Setup

- Where would you like RTM31 to be installed?

The software will be installed in the folder listed below. To select a different location, either type in a
new path, or click Change to browse for an existing folder.

Install RTM31 to:
C:\Program Files (<86)\RTM31 || change...

Space required: 5.01 MB
Space available on selected drive: 346.06 GB

L ocdes | [leer | conce

Figure 1.5: Installation Directory window

The Select Short cut Folder window opens (Figure 1.6).

The setup program will create a RTM31 menu item in the Program menu accessible
by clicking Start. If you do not want to use the proposed folder, you can either enter a
new name, or select an existing folder from the list. Click Next and the Ready to Install

0o RTM31 Setup

1 ‘Where would you like the shortcuts to be installed?

The shortcut icons will be created in the folder indicated below. K you don't want to use the default
Folder, you can either type a new name, or select an existing folder from the list.

Shorteut Folder:
[RTM31 -

() Install shortcuts for cument user only
(@) Make shortcuts available to all users

| <Bacc | [ Ned> [N | Cancel

Figure 1.6:  Select Shortcut Folder window

window will follow (Figure 1.7).

1.
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B0 RTM31 Setup

fou are now ready to install RTM31 V1.17

The ingtaller now has enough information to install RTM31 on your computer.

The following settings will be used:
Install folder: C:"\Program Files (x86)"RTM31
Shorteut folder:  RTM31

Please click Mext to proceed with the installation.

e | [ ] [ e |

Figure 1.7:  Ready to Install window

In case you would like to make any changes before the installation, click Back. To abort
installation click Cancel. If you are ready to start installation, click Finish. The instal-
lation progress bar will appear. The Installing Files window with a progress bar displays
the percentage of the installation completed. When finished, the following window will
appear (Figure 1.8).

0o RTM31 Setup

Installation Successful
The RTM31 V117 installation is complete

Thank you for choosing RTM31!
Please click Finish to exit this installer.

Please visit us at http.//www.geomar.com

= Bach

Eance]

Figure 1.8:  Finished window

Click Finish to end installation. Setup31R creates a RTM31 program group and places
RTM31 and Uninstall icons into it. The setup program creates also a RTM31 menu item
in the Program menu accessible by clicking Start. A reminder to restart the system may
be displayed at the end of the setup program. The destination directory that was chosen
earlier contains program files and sample data files.
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1.4 Program Overview

Start the RTM31 by double clicking the RTM31 icon in the Start|Programs menu, in
Windows Explorer, or on the desktop if a shortcut was created. At the start, RTM31
displays the following screen (Figure 1.9):

File Position Readings Convert Data Files Data Transfer Help

processing RImapal dala files

-

Copyright © 2007-2018 Geomar Software Inc.-

Figure 1.9: RTM31 Main Screen
The RTM31 is a menu driven program. Most of menus items are disabled till a data file

is loaded in to the program. A short description of the possible menu options is given
below.

File Menu

The File Menu is shown in Figure 1.10. Functions accessible from this menu allow you to
load data file, to save data set, to save data set under different file name (Save As), to re-
move loaded data from the program memory (Close), to edit data parameters, to display
two dimensional layout of selected XYZ file, and exit the program.

When program starts most of items in File menu are disabled. As soon as data file is se-
lected and data is loaded to the program memory the splash graphic disappears and the
program displays information related to data file contents, Figure 1.11. At the same time
remaining items in the File menu are enabled.
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File Position Readings Convert Data Files Data Transfer Help

Open File

Save

Save As processing RTmap31 dala files

Close

Edit Parameters
Display X¥7 File

Exit

Copyright © 2007-2018 Geomar Soffware Inc.—

Figure 1.10: RTM31 File menu

File Position Readings Convert Data Files Data Transfer Help

180708_003.T31

Created on 08/07/2018

r~Local [Logger] Time — GPS Time
Started:  23:31:07.320 Started:  03:43:28.43
Ended:  00:31:45.735 Ended:  04:49.06.43
r—Data File Contents——————————— [~ Data File Settings
Et 31 Readings: ha04 ER 31 Standard
GPS Positions: 927
Ireealid GPS Data: 18 Distance Units: ~ meters
Extemnal Senzor Data: 0 GPS Meszage: GGA
Survey Lines: 3 GFS ¥ Offset: 1]
Comments: 1 GPS Y Offset 5
Wertical Mode rdgs: 5204 Survey Mode: Ao
Horizontal Mode rdgs: 0 ExtSensor Type:  Mone
Fiducial M arkers: 0 GPS Elevatior:  Available L\\’

Figure 1.11: RTM31 Main Screen after Loading data file

RTM31 does not allow to overwrite original data file. The Save option is enabled only
when not original data file (i.e. with edited parameters or previously Saved As) was
loaded or after option Save As was used. When original data file is selected the name
of the file and date of the creation is displayed at the top of the screen. In case when
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other than original file was loaded then the current file name is displayed, followed by an
original date of creation and original file name, for example: "Created on 06/02/2018 as
180602_004.T31".

The information displayed by the RTM31 contains Local and UTC time, number and
type of EM31-MK?2 data points and GPS positions, number of survey lines, specified dis-
tance units and GPS antenna offsets, etc. (see Figure 1.11). Four parameters: Instrument
Type, Distance Units, GPS X and Y offsets can be adjusted using the Edit Parameters
item (see Figure 1.12).

[I[] Edit RTmap31 File Param... — O %

Farameter Oniginal fram File Current Sethings

Instrument Type:  Standard 3.6m IStandard 3Em vl
Digtance Units: meters meters 'rI

GPS ¥ Offzet ] 1]

GPS Y Offset 5 IEI?I

GPS offzetz are measured in comezponding Diztance Units

frarm File Cancel | (04 QJ

Figure 1.12: Edit Parameters window

Position Readings Menu

The Position Readings menu represents the main function of the program: positioning
of the EM31-MK2 (or EM31 RT modified unit) sensor based on the system geometry
and GPS positioning (Figure 1.13).

The first item of the menu, Position Sensors using RTmap31 Data File allows you to
position sensors based on Real Time GPS data embedded in RT'map31 file. Using GPS
data the program can also place elevation data in the output file.

The second item, Position Sensors using External GPS File is used to replace Real Time
GPS data by positions from the post-processed GPS data file. The latter requires that
the GPS data is collected in the field computer running RI'map31 program as well as in

1.
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a1 RTM31 - X

File  Position Readings Convert Data Files Data Transfer Help
Position Readings Using RTmap31 Data Files
Position Readings Using External GPS File
Created on 08/07/2018
rLocal [Logger) Tme————————————— ~GPS Time
Started:  23:31:07.320 Started:  03:48:28.43
Ended:  00:31:45.735 Ended: 04:45:06.43
—Data File Contents———————  ~ Data File Settings
EM31 Readings: R204 EM31: Standard
GPS Positions: 927
Invalid GPS Data: 18 Distance Units:  meters
Esternal Sengzor Data: 0 GPS Message: GlGa
Survey Lines: 3 GPS = Offset: 1]
Comments: 1 GPS ' Offset 5
Wertical Mode rdgs: B204 Survey Mode: At
Harizontal Mode rdgs: 0 Ext.Sensor Type:  MNane
Fiducial Markers: a GPS Elevation:  Available

Figure 1.13: RTM31 Position Sensors menu

the GPS receiver logger. GPS data can be processed by the GPS manufacturer software
and then exported as an ASCII file. This option is especially useful in the following
cases:

* when Real Time differentially corrected positioning is not available,

* accuracy of positioning may be further improved by processing data using
special GPS software,

» if special or unique coordinate system provided by GPS software is required
and such coordinates are available from GPS manufacturer software (while
not available in other employed data processing or mapping software).

Convert Data Files Menu

The Convert Data menu has five functions available. The menu is shown in Figure 1.14.

The first item, RT'map31 Files to Geonics G31 Format allows you to convert RI'map31
data files to files that can be loaded to and processed by the Geonics DAT31W program.

The second item, RTmap31 Files to ASCII Format allows you to convert data files to
ASCII text format. This file can be simply used to examine data in text mode, or it can
be easily converted to other formats if required.

10
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St RTM31

~Local [Log
Startec

File Position Readings = Convert Data Files  Data Transfer Help
RTrmap31 (T31) Files to Geonics (G31) Format
RTM31 Files to ASCIl Format

Retrieve and Position Field Comments

GXY File to XY (ASCIl) Format

Correct Time Constant Delay in XYZ File

Ended:  00:31:45.735

|| Ended  04:49.06.43

r Diata File Contents

E31 Readings:
GPS Positions:
Invalid GRS Data:
External Sersor Data:
Survey Lines:
Carmments:

Wertical Mode rdgz:
Horizontal Mode rdgs:
Fiducial M arkers:

5204
927
18

0

3

1
5204
0

0

D ata File Settings
EM3:

Distance Units:
GPS Meszage:
GFS % Offset:
GPS v Offset
Survey Maode:
Ext.Sensor Type:
GPS Elevation:

Standard

meters
GGA

0
A

Auto
Mone
Auvailable

Figure 1.14: RTM31 Convert Data menu

In case when the RTmap31 program was used to acquire stand-alone GPS positions
(without EM data) the data files have extension name GXY. The third item, GXY File
to XY (ASCII) Format can be used to convert binary data file to simple text file with
two to four columns: Easting (Longitude), Northing (Latitude), and optionally Eleva-
tion (including correction for GPS antenna height) and Time Stamp (local time) of each
position record. These files can be used in other applications, i.e. in mapping software
to denote topographical features as roads, fences, etc.. This option can be also used to

convert any RTmap31 data file to a text file containing coordinates and elevation of GPS

positions.

The fourth item of the Convert menu, Retrieve and Position Field Comments allows you

to filter out and position field comments entered by the operator during the survey.

The last option of the Convert menu, Correct Time Constant Delay in XYZ Files can be
used to correct the effect of the system (combined EM31-MK2 and GPS receiver) time
constant delay in two dimensional XYZ files generated during positioning EM31-MK2

data.

1.
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Data Transfer Menu

This menu has one item only providing information how to download data files. It ap-
plies mainly to older field computers (Windows CE and Windows Mobile devices). All
data files collected with Windows 7 or Windows 10 computer can be copied and pasted
using standrad Windows procedures. The menu is shown in Figure 1.15.

File Position Readings

—Local [Logger) Time

Started:  23:31:07.320
Ended:  00:31:45.735

Convert Data Files

Data Transfer Help

[; Download Logger Data Files

180708_003.T31

Created on 08/07/2018

~ GPS Time

Started:  0348:28.43
Ended: 04:45:06.43

— Data File Contents

EM31 Readings:
GPS Positions:
Irwvalid GPS Data:
External Senzor Data:
Survey Lines:
Comments:

‘ertical Mode rdgs:
Harizontal Mode rdgs:
Fiducial Markers:

5204
927
2

0

5204
0
0

— Data File Settings
EM3T:

Distance Units:
GPS Message:
GPS = Offset:
GPS ' Offset
Survey Mode:
Ext.Sensor Type:
GPS Elewvation:

Standard

rnehers
GGA

i
A

Auto
M ane

Available

Figure 1.15: RTM31 Data Transfer menu

Windows CE: Transfer of data files from Allegro CX (Windows CE.NET based field
computer) is handled by the MS ActiveSync program. Therefore the second item of this
menu displays information only (Figure 1.16). Optionally, data files and program files
can be transferred between Allegro CX and other computers by using PC memory card.

F-

k-

e

Please use M5 Activesync or memory card to transfer data files
from Windows CE or Windows Mobile device

Figure 1.16: Allegro CX data transfer info

12
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A PCMCIA card slot is located behind the Allegro display (please see Allegro manual).
Memory card becomes a Storage Card in Allegro CX. Memory card is the fastest and
easiest way of performing data transfer between Allegro and PC computer. In addition
to data transfer, memory card can serve as a data back up device during the survey.

Windows Mobile: Data files from Archer2 (or similar devices) can be transferred using
memory card SD or microSD, or by USB mamory stick (if USB connector iis available).

Help Menu

Item "About" is the only available option in this menu (Figure 1.17). It displays name
and version of the program, as shown in Figure 1.18. A dedicated Help function is not
available in this version of the RTM31.

Ja RTM31 - x

File Position Readings Convert Data Files Data Transfer l:(}elp
About
180708_003.T37
Created on 08/07/2018
r~Local [Logger] Time ~GPS Time
Started:  2331:07.320 Started: 03482843
Ended:  00:31:45.735 Ended:  04:49.06.43
Data File Contents————————————— 1~ Data File Settings
EM31 Readings: 5204 EM31: Standard
GPS Positions: 927
Ireealid GPS Data: 18 Distance Units: meters
External Sensor Data: 0 GPS Message: GGA
Survey Lines: 3 GPS ¥ Offzet: 1]
Comments: 1 GPS ¥ Offset A
Wertical Mode rdgs: 5204 Survey Mode: Auta
Horizontal Mode rdgs: 0 Ext.Sensor Type:  None
Fiducial Markers: 0 GPS Elevation:  Available

Figure 1.17: RTM31 Help menu

A detailed description of the function of each menus item is provided in relevant sections of the
manual.
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File Position Readings Convert Data Files Data Transfer Help

180708_003.T31

Created on 08/07/2018

MPRL| a1 About RTM31

Sty
En
_ RTM31
—Data Fi
i Version 1.17
GPY
I3 Geomar Software Inc.
Exte
Sur
Carrl oo
Wertical Mode rdgs: h204 Survey Mode: Auta
Horizontal Mode rdgs: 0 ExtSenzor Type:  Mone
Fiducial Markers: 0 GPS Elevation:  Awailable

Figure 1.17: About RTM31 window
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File Menu

File menu of RTM31 program is shown in Figure 2.1. There are several items associated with the
File menu:

*  Open File (loads RTmap31 data file to the program memory),

» Save (saves data to the same file, disabled if original data file loaded),
* Save As (saves data to a file with different file name),

* Close (closes current data set),

e Edit Parameters (changes parameters in loaded data set),

* Display XYZ File (displays layout of stations in any XYZ file),

* Exit (terminates RTM31 program).

el RTM31

File Position Readings Convert Data Files  Data Transfer Help

Open File
%a\re

Save As processing RTmap3 1 data files

Close

Edit Parameters
Display XYZ File

Exit

Copyright © 2007-2018 Geomar Software Inc. -

Figure 2.1: RTM31 File menu

When program starts most of items in the File menu are disabled. They are enabled
automatically as soon as data file is loaded in to the program memory.

The general rule of the RTM31 software is that the program cannot overwrite original
file name. In order to Save file, the original file name must be "Saved As" first. The pro-
gram tags such file and menu item Save is enabled. At further runnings when the "Saved
As" file will be loaded item Save will be enabled automatically.

2. File Menu 15



2.1 Open File

The Open File option allows you to load RTmap31 data file to the program memory.
Select File | Open File from the main program menu, as shown in Figure 2.1. After the
selected menu item is clicked the Select RTmap31 Input File window will be displayed in
the centre of the screen, Figure 2.2.

S Select RTmap31 Input File

4[> ThisPC » Windows (C) > Data > RT31dats o|@ | Search RT3 dats r
Organize v Newfolder e @
RT31dsta A Name Date modified Type Size
RIM31 [ 180825 000.T31 T31 File 4B
OneDrive [ 180625 001,731 T31 File £37K8
[ 180625_002.T31 7. T31File 35 KB
O This PC [F 120825 003731 T31 File 18 KB
J 30 Objects [ 130625_004.731 . T31File 21 kB
I Desktop [ 120625 005731 M. TilFile 483 K8
%) Documents [ 180708 000.T31 T31 File bEY
A 2k
3 Downloass [ 130708_001 731 T31 File 24KB
I3 180708_002T31 T31 File 520 KB
D Music = =
[ 130708 00331 T31 File 1,008 KB
&= Pictures
B Videos
i, Windows (C)
= KINGSTON (D)
v
File name: | 180702_002.731 | [RTmap3t Files (31531~
Conce

Figure 2.2:  Select RTmap31 Input File window

The window lists files with extension name T31. Select a file name and click the Open
button. The Select RTmap31 File window will close and the progress bar will appear in
the center of program’s main window indicating percentage of loaded file (Figure 2.3).

As soon as data file is selected and data is loaded to the program memory the splash
graphic disappears and the program displays information related to data file contents. At
the same time remaining items in the File menu (and items in other menus as well) are
enabled and the Open File item is disabled.

The RTM31 main window displays the most important parameters of the entered data
file (Figure 2.4). At the top of the window the current file name, date of file and option-
ally original file name (as entered in the field), and start and end times in local time
(field computer clock) and UTC time (GPS time in NMEA messages) are displayed.
Below, in the left window frame labeled Data File Contents a total number of EM31
readings, number of GPS positions recorded, number of invalid GPS positions (with not
valid checksum), number of survey lines, comments, number of readings in each dipole
mode, and number of used fiducial markers in the field are given. In the right frame
labeled Data File Settings listed are: the EM31 Type (Short or Standard), type of used
GPS NMEA message, GPS X and Y offsets (in Distance Units).

16
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a1 RTM31

File Position Readings Convert Data Files Data Transfer Help

processing RTmapal dafa files

-

Copyright © 2007-2018 Geomar Software Inc.—

Checking GPS Positions Integrity...

Figure 2.3:  Progress bar indicating loading the RTmap31 file

When original data file is selected the name of the file and date of the creation is dis-
played at the top of the screen. In case when not original file was loaded then the current

a1 RTM31
File Position Readings Convert Data Files Data Transfer Help
180708_002.T31
Created on 08/07/2018
r~ Local [Logger) Time ~GPS Time
Started:  23:06:09.699 Started: 03233243
Ended: 232352510 Ended: 03471243
Data File Contents——————————— [~ Data File Settings
EMI Readings: 2463 ErI1: Standard
GPS Positions: 437
Irvvalid GPS Data: 9 Distance Urits: ~ meters
External Sensor Data: 0 GPS Messzage: GGA
Survey Lines: 1 GPS ¥ Offset: 1]
Comments: 1] GPS v Offset 5
Wertical Mode rdgs: 2463 Survey Mods: At
Horizontal Mode rdgs: 0 Ext.Sensar Type:  Mane
Fiducial Markers: 0 GPS Elevatior:  Available

Figure 2.4: RTM31 Main Screen after data file is loaded
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file name is displayed, followed by an original date of creation and original file name, for
example: "Created on 02/03/2008 as 020310A", (see Figure 2.5).

At this point loaded data can be used for further data processing.

2.2 Save, Save As, Close

As it was mentioned data can be saved only if the data file was previously Saved As. This
assures that the original data file will not be overwritten, i.e. with edited parameters.

The File menu item Save is enabled only when other than original data file is loaded.
The indication that file was previously Saved As is given at the top of the screen, under
currently loaded file name label "Created on 17/03/2008 as 031722B" provides informa-
tion that the original file name was 031722B.T31 (Figure 2.5). Otherwise this label would
provide only date of the created file (see Figure 2.6).

a1 RTM31 = X
File Position Readings Convert Data Files Data Transfer Help
Open File
Save N 5_180708_003.T31
SR Created on 08/07/2018 as 80708_00
Close
=] ~ GPS Time
Edit Parameters 3:07.320 Started:  03:48:28.43
Display XVZ File 31:45.735 Ended: 04:45:06.43
Exit — Data File Settings
EM3T Readings: h204 EM31: Standard
GPS Positions: 927
Invalid GPS Data: 18 Distance Units:  meters
Esternal Sengzor Data: 0 GPS Message: GlGa
Survey Lines: 3 GPS = Offset: 1]
Comments: 1 GPS ' Offset 5
Wertical Mode rdgs: B204 Survey Mode: At
Horizontal Mode rdgs: 0 ExtSenzor Type: Mone
Fiducial Markers: 0 GPS Elevation.  Awvailable

Figure 2.5: RTM31 Main Screen with item Save enabled after not
original file was loaded

The File menu item labeled Save As allows you to save any data set. Select File | Save As
from the program main menu (see Figure 2.6). After the selected menu item is clicked,
the Save As RTmap31 Input File window will be displayed in the centre of the screen,
Figure 2.7.
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File Position Readings Convert Data Files Data Transfer Help

Open File

Save 180625_005.T31

Saveds N Created on 25/06/2018

Close

=] ~ GPS Time

Edit Parameters 46:08.577 Started:  04:02:06.43

Display XVZ File 01:57.405 Ended: 04:17:54.43

Exit  Data File Settings
EM3T Readings: 2279 EM3IT: Standard
GPS Positions: 408
Invalid GPS Data: g Distance Unitz: meters
Esternal Senzor Data: 0 GPS Message: GlGa
Survey Lines: 2 GPS ¥ Offset: 0
Comments: 1] GPS ' Offset 5
Wertical Mode rdgs: 2279 Survey Mode: At
Horizontal Mode rdgs: 0 Ext.Sensor Type:  Mone
Fiducial Markers: a GPS Elevation:  Available

Figure 2.6: RTM31 Screen with loaded original data file, disabled
Save option, and selected Save As item
This option is especially useful when data files are loaded several times. Data files cre-
ated in Windows systems (especially Windows CE and Windows Mobile) may be not

i Save As RTmap31 Input File X

4 > ThisPC » Windows (C) > Data » RT31_data v @ | SearchRT31 data »
Organize New folder Ev @
OneDrive A Neme - Date modified Type Size
[ 120625_000.731 2 35, T31File
O This PC =
= [ 180625_001.731 2 T31File
<1 30 Objects [Zl 180625 002,731 2 :37...  T31File
[ Desktop [El 180625_003.731 2 T31File
Documents [ 180625_004.731 2 T3 File
& Downloads [ 120625 005,731 2 04 T31File
B Music [ 180708_000.T31 2 T31File
= Pictures [ 120708_001.731 2 . T3TFile
[ 180708 002731 2 T3 File
B videos -
- [l 180708_003.731 2 . T3TFile
T UETTE(S) [l s 180708 003,731 2 T3 File
= KINGSTON (D) 5 5A_180708_002.T31 2 T31File
KINGSTON M Y
File name: | Saved 180625_005.731 -
Save as type: | RTmap31 Files (.T31,%31) v
~ Hide Folders Cancel

Figure 2.7:  Save As RTmap31 Input File window

organized according to time stamp sequence in several places. When such file is loaded,
first it is sorted by the program. The option Save As will save data in organized format
and additionally checks GPS records integrity, therefore loading previously saved file
will be faster (since sorting is not necessary). The program recognizes sorted files auto-
matically.
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After the file is saved with Saved As option the Main Screen of RTM31 will be updated,
and file name will placed at the top of the screen and the item Save in the File menu will
be enabled, Figure 2.8 (compare with Figure 2.6).

et RTM3 - X
File Position Readings Convert Data Files  Data Transfer Help
Saved_180625_005.T31
Created on 25/06/2018 as 80625_00
~Local [Logger] Time———————————— ~GPS Time
Started:  23:46:08.577 Started:  04:02:06.43
Ended:  O0:01:57.405 Ended: 04:17:54.43
Data File Contents—————————— [~ Data File Settings
Er31 Readings: 2279 Er31: Standard
GPS Positions: 406
Irvalid GRS Data: 2 Distance Unitz:~ meters
Euternal Senzor Data: [0 GPS Message: GGA
Survey Lines: 2 GPS ¥ Offset: 0
Camments: 1] GPS Y Offset 5
‘Wertical Mode rdgs: 2279 Survey Mode: Auta
Horizontal Mode rdgs: 0 Ext.Sensor Type:  MNone
Fiducial Mark ers: 0 GPS Elevation:  Available

Figure 2.8: RTM31 Main Screen after completed Save As option

Clicking on the Close item in File menu will remove data set from the program memory,
the Main Screen will display splash graphic and the menu item Open File will be en-
abled. This action allows you to load another RTmap31 data file.

2.3 Edit Parameters

Four parameters entered during the field work can be modified during data processing.
Click on the Edit Parameters item in the File menu and the Edit RTmap31 File Param-
eters window will appear (Figure 2.9). The Edit Parameters window is also available in
Position Readings options.

The window displays parameters that the user can edit. These are: EM31-MK2 Type
(Short or Standard), Distance Units, and GPS X and Y offsets. If all parameters were
correctly specified in the field then clicking on OK or Cancel button will accept these
entries. In case some of the parameters require modification they can be entered in ap-
propriate text boxes located under label Current Settings. Instrument Type and Distance
Units can be selected from combo list boxes, while GPS X and GPS Y offsets must be
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(] Edit RTmap31 File Paramet...

Parameter Original fror File  Current Settings

Instrument Tepe:  Standard 3.6m IStandard 26m vl
Distance Units: meters meters %!
GPS ¥ Offzet 1] 1]
GPS Y Offzet 5 |.5

GPS offzets are measured in corezponding Distance Units

fram Eile Cancel |

Figure 2.9: Edit RTmap31 File Parameters
window

entered in appropriate text boxes. Example of RI'map31 File Info window with modified
parameters is shown in Figure 2.10.

[l Edit RTmap31 File Paramet...

Farameter Original from File  Current Settings

Instrument Type:  Standard 3.Bm IStandard 3.6m vl
Distance Units: meters meters vl

GPS5 & Offset o ]

GPS " Offset 5 I-.ll

GPS offzets are measured in coresponding Distance Units

fram Eile | icancel | )4 I}J

Figure 2.10: Modified parameters in Edit
Parameters window

Clicking on the OK button will accept any changes, clicking on the Cancel button will
cause the program to use initial parameters (state when window was displayed), while
clicking on the button from File will change parameters to original values (listed in fields
under label Original from File). After the buttons OK, Cancel or from File are clicked
the Edit RTmap31 File Parameter will disappear.
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Any updates in this window are valid only for duration of the program. The data file will
remain the same unless it Saved or Saved As in File menu.

2.4 Display XYZ File

The Display XYZ File option allows you to display two dimensional layout of stations
in a selected XYZ file. Select File| Display XYZ File from the main program menu, as
shown in Figure 2.1. The Select XYZ to Open window will appear.

The window lists files with extension name XYZ. Select a file name and click the Open
button. The Select XYZ to Open window will close, the file will be loaded and two di-
mensional image will be displayed (Figure 2.11).

The image displayed in the Plot XYZ window shows the spatial layout of stations to
scale, based on the station coordinates as written in the selected XYZ file.

Figure 2.11: Two dimensional layout of stations in XYZ File
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Position Readings

Positioning of the Geonics EM31-MK2 sensor is the main function of the RTM31. Location of
the electromagnetic sensor is calculated based on the recorded GPS position, instant heading of
the system, and the system geometry which is described by the location of GPS antenna.

There are two methods of positioning sensors in RTM31: Position Sensors using RTmap31 Data
File and Position Sensors using External GPS File. The first method allows you to position sen-
sors based on Real Time GPS data embedded in RTmap31 file while in the second technique
Real Time GPS data are replaced by GPS positions from the postprocessed GPS data file. The
second method requires that the GPS data is collected in the field computer running RTmap31
program as well as in the GPS receiver logger. This option is especially useful in following cases:

e when real time differential data correction is not available,

* accuracy of positioning may be further improved by processing data using special
GPS software,

¢ if a special or unique coordinate system provided by GPS software is required and it
is available in other GPS sytem(and it cannot be obtained in employed data process-
ing or mapping software).

Description of functions involved in positioning the EM31-MK2 is preceded by a short descrip-
tion of the system geometry.

3.1 The RTmap31 System Geometry

The GPS antenna can be placed anywhere in relation to the instrument center. However
to achieve the highest possible accuracy of the calculated positions the GPS antenna
must be placed as close to the center of the system as possible. The best and optimal
placement of the GPS antenna is located above the center of the EM31-MK2 sensor.

When a survey is positioned by GPS system and GPS antenna can not be placed in the
center point of the instrument the program allows to specify the GPS antenna offset
from the EM31-MK2 sensor center. Two parameters, GPS X Offset and GPS Y Offset
describe location of GPS antenna. This location is represented by the distance which is
measured from the center of the EM31-MK2 antenna to the center of the GPS antenna,
while facing direction of the movement, see Figure 3.1.
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Figure 3.1: The EM31-MK2 and GPS antenna geometry
The procedure of specifying X and Y offsets in relation to the direction of the system
movement is very important and should be maintained during data collection for the en-
tire data set. Therefore, the operator cannot walk few steps or drive backwards without
changing data file name. If it is necessary data logging must be paused for the time of
such movement since positioning of the sensor based on GPS is based on this assump-
tion.

EM31

System Reference Point (0, 0)

This option is provided mainly for situations where the operator carries the EM31-
MK?2, and GPS antenna (placed in backpack) is located above his shoulder. In this case
distance between GPS antenna and the instrument (GPS X Offset) is relatively small
(less than 0.5 m), and GPS Y Offset will be usually very small as well and its sign will
depend on whether the center of the instrument is in front or behind the GPS antenna.
This situation corresponds to the system geometry presented in Figure 3.1. Another case
that offsets have to be used is when longer cable from GPS receiver to GPS antenna is
unavailable.

The offset in Y direction (GPS Y Offset) can be used if the instrument is towed and the
GPS antenna is located on the same trailer or on the towin vehicle (Figure 3.2). It is
always advised to make the GPS Y offset as small as possible to achieve better position-
ing accuracy. The RTM31 calculates positions using advanced interpolation based on
time stamps, neighbouring GPS positions, as well as projected EM31 positions along
curved lines to achieve positioning as accurate as possible. However, as it was mentioned
earlier, the highest accuracy is achieved when the GPS antenna is located above the cen-
ter of the EM31-MK2 sensor. In case where the GPS antenna is located in front of the
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Figure 3.2:  Geometry of the EM31-MK?2 sensor and GPS antenna
during towing

electromagnetic sensor the GPS Y Offset is positive, and if the GPS antenna is located

behind the instrument the GPS Y Offset is negative.

In the case where a wrong value was entered in the field, GPS X Offset and GPS Y Off-
set parameters can be corrected later during data processing in the program RTM31.

In general, when GPS antenna is located off the center of the system positions of the
instrument will be calculated based on the GPS antenna position including neighbouring
points, instant heading, and projection of neighbouring calculated sensor positions. In
order to achieve higher quality of data positioning the survey should be carried out along
relatively smooth pathways, especially if GPS antenna is located further from the center
of the instrument.

When the direction of the survey line is changed it is advised to pause recording of data
for the duration of U-turn. Toggling between Stand By mode (pause) and Log mode is
relatively easy in the most difficult field conditions, it is done by one key stroke (Pause
and Start keys), and it can save time during data processing.

Similar approach applies to situations when the system is stopped. In this case if readings
are not paused, the random distribution of small GPS errors will likely result in unreli-
able locations of calculated sensor positions. If the offset of GPS antenna is used it may
appear that the instrument is rotating since GPS errors occur in many directions. Paus-
ing readings while the system is stopped will save time during data processing and will
result in better data presentation.
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3.2 Positioning Readings Using RTmap31 Data File

After a data file is loaded the RTM31 main window displays the most important parame-
ters of the entered data file (Figure 3.3). At the top of the window the current file name,
date of file and optionally original file name (as entered in the field), and start and end
times in local time (field computer clock) and UTC time (GPS time in NMEA mes-
sages) are displayed. Below, in the left window frame labeled Data File Contents a total
number of EM31-MK2 readings, number of GPS positions recorded, number of invalid
GPS positions (with not valid checksum), number of survey lines, comments, number of
readings in Vertical and Horizontal dipole modes, and number of used fiducial markers
in the field are given. In the right frame labeled Data File Settings listed are: type of the
instrument, units, type of used GPS NMEA message, GPS X and Y offsets (in Distance
Units), and survey mode.

The Position Readings Using RTmap31 Data option allows you to position EM31-MK2
stations based on Real Time GPS data which were recorded in RTmap31 data file during
the survey. Select Position Sensors | Position Readings Using RTmap31 Data Files from
the main program menu, as shown in Figure 3.3.

St RTM31

Position Readings Using RTmap31 Data Files
Position Readings Using External GP5 File

File = Position Readings Convert Data Files  Data Transfer Help

s

~ Local [Logger) Time

Started:  11:44:38.539
Ended:  11:51:28532

Created on 03/04/2019

r Diata File Contents

E31 Readings:
GPS Positions:
Invalid GRS Data:
External Serzor Data:
Survey Lines:
Carmments:

‘Wertical Mode rdgs:
Harizontal Mode rdas:
Fiducial M arkers:

~GPS Time
Started:  16:00:20.43
Ended: 16:07:08.43
D ata File Settings
1606 EM31: Standard
140
3 Distance Units:  meters
0 GPS Meszage: GEA/GSA
2 GPS x Offset: -3
1 GPS ' Offset 0
1606 Survey Maode: At
0 ExtSenzor Type: Mone
0 GPS Elevation:  Available

Figure 3.3:  Position Readings menu

After the selected menu item is clicked the Position EM31-MK2 Readings Using RT-
map31 Data File window will be displayed in the centre of the computer screen, Figure

3.4.
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Parameters in Positioning Readings Using RTmap31 Data File Window

Pasition EM31 Readings Using RTmap31 File
g g p:

Output 37Z File | |
— Twpe of Dutput File

Edit Parameters Beplot Last Output File * Generic ( Geomoft © ESAP

—Select EM31 Data Tupe

" Dipole Mode Indication

Iv Disable Automatic Dipale Mode Indication ™ CondMert ™ Cond/Moriz
— Dutput Coordinates [wWES84)——————— ' Inphazedert " Inphase/Horiz
 Beodetic Format——————————————— & Both/ert i~ Both/Horiz
& DDD.DDDDDDDD
' DDDMM bbb — Select Optoional Data

[™ Elevaton W GPSOC v Time

o UTH Units
|Meters vI ‘ AnternaHeight [000 & m ¢ i

—GPS Time Gap — GPS Minimum Interval —— — G54 Meszage Include in File
& meters g ¥ Header Info
|5 seconds Iu_g [~ Disable
" feet —‘ ’7 ¥ Figld Commants
—PDOP Mask — Carrections————— [~ Position Mode
@ 30 valid only for
R e e oz
¥ Pasitive Only 20 GGA/GSA

Bl |

Figure 3.4:  Position EM31-MK2 Readings Using RTmap31
Data File window

Several parameters which affect the contents and format of the created output (XYZ)

file must be specified. These are the XYZ output file name, parameters describing con-

tents and format of the created file and parameters related to electromagnetic as well as

to GPS data.

Edit Parameters

The RTM31 main window (Figure 3.3) displays the most important parameters
of the entered data file. In case some parameters were wrongly entered in the
field it is possible to change them using Edit Parameters option (the same op-
tion is available in the File menu of the RTM31 main screen). Click on the Edit
Parameters button and Edit RTmap31 File Parameters window will appear
(Figure 3.5).

The window displays parameters that the user can edit. These are: the EM31-
MK?2 type, Distance Units and GPS X and Y offsets. If all parameters were
correctly specified in the field then clicking on OK or Cancel button will accept
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Qutput 37Z Fils |

Edit Pararmet i ESAP

Dipale Mode [r
¥ Disable & Parameter Original from File  Current Settings Cond/Hariz
~ Output Coording Inphase/Horiz

 Geodstic Instrument Type:  Standard 3.6m IStandard 3Em vI Both/Horiz
Digtance Units: meters meters - v Ti
- l ac W Time

GPS 3 Offset .3 3 (P,
GPS v Offset ] I 0
—GPS Time Gap 2 in Filz
|5 zecal  GPS offsets are measured in corresponding Distance Units sader Info
eld Comments
~PDOF Mask — frarm Eile | Cancel |
|4 GGAG
hiterenhal [OGFS] Proceed
v Paositive Only ‘ ‘ ! = | ‘ 20 GGA/GSA
|
Cancel | E it |

Figure 3.5:  Edit RTmap31 File Parameters window

these entries. In case some of the parameters require modification they can
be entered in appropriate text boxes located under label Current Settings.
EM31-MK?2 Type and Distance Units parameters can be selected from combo
list boxes, while GPS X and GPS Y offsets must be entered in appropriate text
boxes. Example of RTmap31 File Info window with modified parameters is
shown in Figure 3.6.

Clicking on the OK button will accept any changes in parameters, clicking on
the Cancel button will cause the program to use initial parameters (state when
window was displayed), while clicking on the button from File will change pa-
rameters to original values (listed in fields under label Original from File). After
the buttons OK, Cancel or from File are clicked the Edit RT'map31 File Param-
eter will disappear.

Any updates in this window are valid only for duration of the program. The data
file will remain the same unless it is Saved or Saved As in File menu.

Output File

Click on the Output XYZ File button. The Select Output File window is dis-
played (Figure 3.7).
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Figure 3.6:  Modified parameters in Edit Parameters window

Select a file name and click the Save button. The Select XYZ File window will
close and the selected file name will be displayed beside the Output XYZ File
button in the Position EM31-MK2 Readings Using RT'map31 File window.

[ Select Output File

« © 4[> ThisPC > Windows (C) » Data > RT31data v|o]| | Search RT31_data p
Organize v New folder == e
Ri3idats A Name Date modified Type Size
OneDrive 180625 2z 2 XVZFile 201 K8
) 180625_2_GPSxyz 2 XVZFile 2k
& ThisPC -
= 180708 0023272 2 XVZFile 216ke
< 30 Objects ] 120708_00222_GPS.xy2 2 XVZ File 2K8
[ Desktop ) 180708_003.xyz 2 XVZFile 260 KB
Documents. 7 120708_002_GPSuxyz 2 XVZFile 47KB
3 Downloads 1809170072 2 KVZFile 180K8
b Music 1 180817 6PS.cyz 2 . XVZFile 198
D oryz 2 KVZFile 460KB
5] Pictures -
T o GPsxyz 2 XVZFile 47K8
B viseos Ty 2 XVZFile 6K8
o Windaw= [C) 1 vy GRS 2 XVIFile 1K8
& Netwunr v
File name: | 120403_000] -
Sove os type: | KVZ Files ("ay2) >
i B G
Figure 3.7:  Select Output File window

When Output file is specified the Proceed button in the Position EM31-MK2
Readings Using RTmap31 File becomes active (Figure 3.8).

3. Position Readings
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EM31-MK2 Data (Both Components)  (Select EM31-MK2 Data Type)

To select a data type (component and dipole mode) click on desired radio but-
tons labeled Cond/Vert, Inphase/Vert, Both/Vert for vertical dipole mode, and
similarly for Horizontal dipole mode Cond/Horiz, Inphase/Horiz, Both/Horiz.
Data is always placed in the created XYZ file in the following order: X coordi-
nate (Easting or Longitude), Y coordinate (Northing or Latitude), and selected
component for selected dipole mode. If data type containing separation "Both"
was selected (Both/Vert or Both/Horiz) then the order is Conductivity and
Inphase for selected dipole mode. This data may be followed by one or more
columns containing Elevation, GPS Quality parameters, and Time Stamp (this
optional parameters are located in a section Select Optional Scale).

If parameter Header Info in Include in File section is checked a line listing all
parameters in the file will be placed as a header for each created XYZ file.

Dipole Mode Indication

If the checkbox labeled Disable Automatic Dipole Mode Indication is checked
the program will ignore reading dipole mode tags and it will write all data
(within selected coil separation) in XYZ file, regardless dipole mode selection
in EM31-MK2 Data section.

This option may be very useful when the survey is performed using trailer
mounted instrument. In this case a dipole mode indicator in the instrument may
output false information due to strong vibrations caused by terrain obstruc-
tions. Therefore, while carrying survey with trailer or in harsh terrain in lets say
Vertical mode, it is possible to have some Vertical readings tagged as Horizontal
dipole mode reading.

Select Optional Data

Three optional data can be written in the output file. These are Elevation, GPS
QC parameters (Quality Indicator, PDOP or equivalent, number of satellites),
and Time Stamp for each reading. To select optional data click on the check box
next to the corresponding name.

If the check box labeled Elevation is clicked (checked) then a text box labeled
Antenna Height and two radio buttons labeled m and ft become active. The
text box labeled Antenna Height allows you to enter correction for Elevation
data. The Antenna Height corresponds to the distance between ground surface
and GPS antenna. If Antenna Height is set to zero then elevations for the GPS
antenna (not the ground surface) are written to the output file. Two radio but-
tons labeled m (meters) and ft (feet) allows you to specify units for elevation
data placed in the output file. It is assumed that Antenna Height parameter is
entered in units specified by these radio buttons.
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Figure 3.8:  Position EM31-MK2 Readings Using RTmap31 Data
File window

Elevation values base on the recorded GPS data. Therefore Elevations will not
be written to the file if the NMEA message GLL was used during the survey.
Message GLL does not contain elevation data. Data is always placed in the
created XYZ file in the following order: X coordinate (Easting or Longitude),
Y coordinate (Northing or Latitude), EM31-MK2 data type (as selected, 1 or
2 values), Elevation, three GPS QC parameters (Quality Indicator, PDOP or
equivalent, Number of Satellites), and Time Stamp.

If parameter Header Info in Include in File section is checked a line listing all
parameters in the file will be placed as a header for each created XYZ file.

Type of Output File

Check the option appropriate for the contouring software used. The Generic
option will create a four or more column file without any text strings. This file
can be used as an input file for many contouring packages (including Surfer).
Geosoft format will cause the program to write LINE # at the beginning of each
survey line. The XYZ file in ESAP format is designed to be an input file for the
ESAP software package developed by United States Department of Agricul-
ture, Agricultural Research Service. Please refer to ESAP manual for descrip-
tion of the format. Since the ESAP input is limited to 32000 readings per file,
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the RTM31 will open new files named _1, 2, etc. should the data set is larger
than 32000 readings. Data written in this format will not contain any additional
parameters including time stamp, nor headers even if they are selected, only
sequential number of station, coordinates, and conductivity readings (for one or
both coils separations) will be placed in the file. The example of the file in the
ESAP format is given in Appendix B.

Include in File

This section contains two check boxes labeled Header Info and Field Com-
ments. When Header Info box is checked the file will contain a header listing
type of coordinates and names of data contained in each column of created
XYZ file. Checking box labeled Field Comments will cause the program to
write text of all field comment (entered by the operator during the survey) in to
the created file.

Output Coordinates

Positions can be written in the output file as geodetic (geographical) coordinates
(Latitude/Longitude) or they can be converted to UTM coordinates. The pro-
gram uses the WGS1984 datum. To select coordinates click Geodetic or UTM
radio buttons (Figure 3.9).

Geodetic coordinates, Latitude and Longitude are given in degrees. They can
be written in two formats DD.DDDDDDDD or DDMM.MMMMM (native
format found in NMEA GPS messages). To select which format click the ap-
propriate radio button in Format section located at the radio button labeled
Geodetic. This section is active only when radio button Geodetic is selected.

UTM coordinates can be generated in meters, feet, or US Survey feet. To select
units for UTM coordinates select proper parameter from the combo box located
in the Units section located at the UTM radio button (Figure 3.9). This combo
box is active only when radio button labeled UTM is selected.

GPS Time Gap

Differentially corrected GPS data often has gaps, due to differences in the con-
stellation of satellites visible to two (fixed and moving receivers), lack of beacon
signal, surveying near trees, buildings, and other elevated obstructions. These
gaps are filled by RTM31 with the assumption that the GPS receiver speed is
essentially constant and that it moves along a straight line during the gaps.

The GPS Time Gap parameter specifies the maximum time during which the
EM31-MK?2 data will be linearly interpolated between two GPS positions. Enter
this parameter (in seconds) in the edit box labeled seconds in the GPS Time
Gap section (Figure 3.9). In most cases a value 2 to 5 times larger than the GPS
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data acquisition frequency is adequate, however the user has to determine this
value based on the survey specific conditions and requirements. To ignore effect
of this parameter enter a large number of seconds (i.e. 999 or more) as GPS
Time Gap parameter.

GPS Minimum Interval

The GPS Minimum Interval parameter specifies the minimal distance between
two GPS stations that will be used in interpolation. If this distance is smaller
than the specified GPS Minimum Interval, then all EM31-MK?2 readings located
between these two stations will be ignored. This parameter is useful in cases
when the operator stops for a moment and data are collected in one point.
Limited accuracy of GPS positioning will create randomly distributed positions
in area adjacent to the stationary location of the system. If RTM31 will calcu-
late positions of sensor in case offset values (GPS X and/or GPS Y Offsets) are
different than zero, positions of the EM31-MK2 will have quite large varia-
tions associated with apparent change of direction of the survey line caused by
randomly close spaced GPS positions. In most cases a value 2 or 3 times smaller
than average distance between two GPS stations is adequate, however the user
has to determine right value for this parameter which will depend on survey
conditions and first of all accuracy of the employed GPS receiver. To ignore the
effect of this parameter and to use all stations during creating XYZ file (i.e.
during testing when GPS antenna is stationary) set this parameter to zero.

Enter the GPS Minimum Interval in the edit box and check one of the two radio
buttons labeled meters and feet (indicating distance unit) in the GPS Minimum
Interval section (Figure 3.9).

GSA Message

This parameter is used to disable GSA message. This is to be used only if the
operator has specified in the data acquisition program (RTmap31) that the
GPS Message will be pair GGA/GSA and for any reason message GSA was not
recorded. In such case the RTM31 will search for GPS quality information con-
tained in not recorded GSA statement and it would conclude that GPS readings
are invalid. Disabling GSA message in this situation causes that the program
will use only information available from GGA message. Recent versions of the
program detect presence of GSA statement automatically.

PDOP Mask

The PDOP Mask is used to filter quality of GPS positions. The index called
PDOP (Position Dilution of Precision) measures the strength of satellite cover-
age for a given area. PDOP is affected by the number of satellites visible and
their relative positions in the sky. The smaller the number of PDOP the stronger
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the satellite coverage is. When there are more than 5 satellites widely spaced
visible, the PDOP is 4 or less. However, when there are less satellites visible, or
they are unevenly spaced in the sky, PDOP values can be 6 or higher. In most
cases, the PDOP in open sky is less than 3, and most accuracies given for many
GPS systems are given for this norm. The index called GDOP covers time accu-
racy in addition, while the index HDOP is related only to horizontal position fix
(it is used when message GGA was selected). Refer to GPS documentation and
literature for more information related to error sources of GPS positioning.

The section PDOP Mask may differ depending on GPS NMEA message used. It
is related to PDOP parameter if GGA/GSA, POS, or GGK was employed dur-
ing the survey, to HDOP if GGA was used, to GDOP if LLK was used during
the survey, and it is invalid if GLL or LLQ message was used.

Enter the PDOP (HDOP or GDOP) value in the edit box in the PDOP Mask
section, Figure 3.9. All positions (as well as EM31-MK2 readings) associated
with GPS data of higher than specified value of this index will be ignored.

Corrections

Select type of differentially corrected position data to be used during the cre-
ation of XYZ file in the combo list box labeled Corrections. Four types of GPS
corrections are given: Raw (GPS), Differential (DGPS), Differential (RTK 3),
Differential (RTK 4), and so on till Differential (RTK 9). All but two first types
of corrections RTK (real time kinematic) are available in higher end of GPS
receivers and differently named depending on manufacturer, however in NMEA
specifications they indicate Quality Parameter 3, 4, 5, and so on. When Raw is
selected, both differentially corrected and raw GPS data are used to calculate
positions of EM31-MK?2 stations.

Position Mode

This option is valid only if the pair GGA/GSA messages were used during data
collection. If radio button labeled 3D is checked then GPS data in mode 3D are
used, while when radio button 2D is checked then program uses 2D as well as
3D mode of GPS data.

It should be noted that if any NMEA message indicates that GPS position (fix) is invalid
this data is ignored by the RTM31.
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Creating XYZ Files With Positioned Readings

When all parameter are set and output file name is specified, the Proceed button is
activated in the Position Readings Using RT'map31 File window. After you click the
Proceed button, the program begins to filter loaded data, calculates EM31-MK2 stations
positions based on the recorded GPS readings, instant heading, and other specified pa-
rameters, and writes results to the XYZ output file. A progress bar at the bottom of the
screen shows the percentage of the file processed (Figure 3.9).

(1 Position EM31 Readings Using RTmap31 File X

Output 372 File IC: WDatah AT 31_datah190403_000.4wz

— Twpe of Dutput File
Edit Parameters | Beplot Last Output File * Generic ( Geosoft  ESAP

"Dipole tode Indication —Select EM31 Data Type

[v Disable Automatic Dipole Mode |ndication ™ CondAert ™ Cond/Hariz
~ Dutput Conrdinates [WGSS4 " Inphazefdert " Inphase/Horiz
€ Geodst Format——————— ' Both/ert " Bath/Horiz
FadRE & DOD.DDDDDODD
' DDDMM bbb — Select Optoional Data

[™ Elevaton W GPSOC [# Time

* UTM Units
[ IMEtE'S 'I ‘ Antenna Height [0.00 & m O f

—GPS Time Gap — GPS Minimum Interval —— — G54 Message Include in File
% meters A W Header Info
|5 seconds 0z [~ Dizable
" fest ¥ Field Comments
—PDOP Mask — Carrections————— [~ Position Mode

3D walid only for

[+ GoamGsa [Diferential DEPS] _+] |
Differential [DGPS] ; Broceed
ifferential | ) 20 GGA/GSA [ —

v Paositive Only

Testing GPS Positions LCancel | E st |

Figure 3.9:  Position EM31-MK2 Readings Using RTmap31 File
window during creating XYZ file

The speed of this operation depends on the size of the input file. After the output XYZ
file is created a two dimensional layout of the survey is displayed (Figure 3.10).

The image displayed in the Plot XYZ window shows the spatial layout of stations to
scale, based on the station coordinates as written to the created file. The display has
fixed colours. GPS positions are marked by larger grey dots while the EM31-MK2 sta-
tions are plotted by smaller red dots. This plot window can be closed by clicking on Close
button (located in the top right corner of the window).
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Figure 3.10: Two dimensional layout of stations taken with the Geonics EM31-MK2. The GPS
X and Y offsets were set to zero (GPS antenna was located above the center of the
EM31-MK2 sensor).

After the Plot XYZ window is closed a button Replot Last Output File becomes ac-

tive and the layout of data can be examined again. However, at this time original GPS
positions will not be displayed and only instrument positions will be represented by red
dots on the screen. Files created by this portion of the program can be also viewed at any
time using the File|View XYZ File menu.

After the file is created and its layout is examined it is possible (if required) to recreate
XYZ file with changed system geometry parameters. To do this, click Edit Parameters
button, the Edit RTmap31 File Parameters window will appear again. After changes are
done, click the Proceed button to repeat procedure of creating XYZ file. See example
in Figure 3.11 where GPS antenna location was changed as compared to case shown in
Figure 3.10.

If the input file does not contain sufficient GPS information, or parameters are not
correctly selected, the program will display a warning message (Figure 3.12), and the
program will pause operation till the OK button is clicked in the warning window.

This message may indicate lack of GPS data in the file, however in most cases it reflects
lack of GSA messages when GGA/GSA was selected in the data acquisition program
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[
Figure 3.11: Two dimensional layout of stations taken with the EM31-MK?2. The GPS antenna
location: GPS X Offset = -0.6 m and GPS Y Offset = 0.00 m (the first W line was
surveyed in N direction).

(check Disable GSA Message), raw positions only when Differential button is checked,
too small value specified in GPS Time Gap section, not existing EM31-MK2 channels
specified in Select Data section, etc..

RTM31

Fa Mo instrument readings,
LE check file content and parameters settings: GP5 Time Gap, GP5
Minimum Interval,
and instrument Data Selection in dialog, GPS positions will be
plotted only,

Figure 3.12: Warning window
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3.3 Positioning Readings Using External GPS File

After a data file is loaded the RTM31 main window displays the most important param-
eters of the entered data file (Figure 3.13). At the top of the window the current file
name, date of file and optionally original file name (as entered in the field), and start
and end times in local time (field computer clock) and UTC time (GPS time in NMEA
messages) are displayed. Below, in the left window frame labeled Data File Contents

a total number of EM31-MK2 readings, number of GPS positions recorded, number
of invalid GPS positions (with not valid checksum), number of survey lines, comments,
number of readings in the Vertical and Horizontal dipole mode, and number of used
fiducial markers in the field are given. In the right frame labeled Data File Settings
listed are: type of the instrument, units, type of used GPS NMEA message, GPS X and
Y offsets (in Distance Units), and survey mode.

The Position Sensors Using External GPS File item of the Position Sensors menu allows
you to position EM31-MK2 stations based on separately logged GPS positions which
were postprocessed by a GPS software and then exported to ASCII format file. It is as-
sumed that GPS positions were concurrently recorded by RT'map31 program during the
survey. Select Position Sensors | Position Readings Using External GPS File from the
main program menu, as shown in Figure 3.13.

St RTM31 - X
File = Position Readings Convert Data Files  Data Transfer Help
Position Readings Using RTmap31 Data Files
Position Readings Using External GP5 File
Created on 03/04/2019
~Local [Logger) Time———————— ~GPS Time
Started:  11:44:38.539 Started:  16:00:20.43
Ended:  11:51:28532 Ended: 16:07:08.43
Data File Contents—————————— [~ Data File Settings
E31 Readings: 1606 EM31: Standard
GPS Positions: 140
Invalid GRS Data: 5 Distance Units: meters
Esternal Senzor Data: 0 GPS Meszage: GEA/GSA
Survey Lines: 2 GPS ¥ Offset; 0
Comments: 1 GPS ¥ Offset a
‘Wertical Mode rdgs: 1608 Survey Mode: Auta
Horizontal Mode rdgs: 0 Ext.Sensor Type:  MNone
Fiducial Markers: 0 GPS Elevation:  Available

Figure 3.13: Position Readings menu
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After the selected menu item is clicked the Position EM31-MK2 Readings Using Exter-
nal GPS File window will be displayed in the centre of the screen, Figure 3.14.

[I[] Position EM321 Readings Using External GPS File

Input GPS File | |
Output 377 File | |

— Tupe of Output File

Edit Parameters ﬂ FiePlot Last Output File " Generic & Geozoft
— Format of the Esternal GPS File—————————— —Select EM31 Components
& UTM Coordinates  Calumn & Conductivity and Inphase
Units .
& ot Easting / LON [z " Conductivity
 fent Northing / LAT |3_ " Inphase ¥ Time Stamp
CUS Suveytest | Tine (hhmmss) |5 ~ Select EM31 Dipols Mode
" Geodetic (DDD.OD...) " Vertical Dipole Mode
% UTC/TALGPS TimeL T 4 " Harizontal Dipale Mode
v E
IS seeanes v Disable Automatic Mode Indication
—GPS Time Gap GPS Minimumn Interyal— — Dutput File Comments
|5 seconds ID ' meters ¥ Header Info Proceed
’V " fest ¥ Field Comments B

Exit

Figure 3.14: Position EM31-MK2 Readings Using External GPS
File window

Parameters in Positioning Readings Using External GPS File Window

Several parameters which affect the contents and format of the created output (XYZ)
file must be specified. These are GPS and XYZ file names, parameters describing
contents of the created file and parameters related to GPS as well as to electromagnetic
data.

Edit Parameters

The RTM31 main window (Figure 3.13) displays the most important param-
eters of the entered data file. In case some parameters were wrongly entered in
the field it is possible to change them using Edit Parameters option (the same
option is available in the File menu of the RTM31 main screen). Click on the
Edit Parameters button and Edit RTmap31 File Parameters window will appear
(Figure 3.15).
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Edit Paramet Parameter Qriginal from File  Current Settings b Geosoft
r— Farmat of the Ext ks
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|5— sec0 fram File Cancel | [0]8 m’J Proceed
T T — T

LCancel | Exit

Figure 3.15: Edit RTmap31 File Parameters window

The window displays parameters that the user can edit. These are: the EM31-
MK?2 Type, Distance Units and GPS X and Y offsets. If all parameters were
correctly specified in the field then clicking on OK or Cancel button will accept
these entries. In case some of the parameters require modification they can be
entered in appropriate text boxes located under label Current Settings. The
Instrument Type and Distance Units parameters can be selected from combo
list boxes, while GPS X and GPS Y offsets must be entered in appropriate text
boxes. Example of RTmap31 File Info window with modified parameters is
shown in Figure 3.16.

Clicking on the OK button will accept any changes in parameters, clicking on
the Cancel button will cause the program to use initial parameters (state when
window was displayed), while clicking on the button from File will change pa-
rameters to original values (listed in fields under label Original from File). After
the buttons OK, Cancel or from File are clicked the Edit RTmap31 File Param-
eter will disappear.

Any updates in this window are valid only for duration of the program. The data
file will remain the same unless it Saved or Saved As in File menu.
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[|[] Position EM31 Readings Using External GPS File x

Imput GPS File | |

Output 272 Filg
[I] Edit RTmap31 File Paramet...
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Figure 3.16: Modified parameters in Edit Parameters window

Input GPS File

Click on the Input GPS File button. The Select External GPS ASCII File win-
dow is displayed (Figure 3.17).

[1] Select External GPS ASCII File

<« v 4 [ > ThisPC > Windows (C}) » Datz » RT31_data v & | SearchRT31 data »
Organize v New folder B> ™ @
BxternalGpsFiles A Name Date modified Type Size
RT31_data 7 TRext03.A5C ASC File 219K8
RTmap31 7] TRext19.A5C ASC File 219KB
OmeDrive T TRestsLAsC ASC File 316K8
2 TRext23.A5C ASCFile 165 K8
[ This PC T yyasc ASC File 19KB
B 3D Objects
[ Desktop
Documents
4 Downloads
D Music
&) Pictures
B Videos
L, Windows (C)
v
File nome: | TRex18.A5C | Position Files ("t masc " pos)
=

Figure 3.17: Select External GPS File window

Select a file name and click the Open button. The Select External GPS ASCII
File window will close and the selected file name will be displayed beside the
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Input GPS File button in the Position Sensors Using External GPS File window.
The external GPS file must be in ASCII (text) format with column delimiter

set to comma or spaces. Several examples of the external GPS files are given in
Appendix B.

Output File

Click on the Output XYZ File button. The Select Output File window is dis-
played (Figure 3.18).

M7 Select Qutput File X
<« “ 4 [l » ThisPC » Windows(C) » Data > RTmap3! » v O | Search RTmap31 »
Organize = Newfolder = -

RT31_data A Name Date modified Type Size ~
RTmap31 77 120708 003 GPS.xyz 1.31..  XVZFile 4ATKB
E BOKI
OneDrive 160917y . XYZFile 180 KB
1 180917_GPS.xyz o XVZFile 19KB
0 This PC 1) 190403_000.xy2 M XYZFile 122K8
8 3D Objects 7 190403 _000_GPS.xyz M XYZFile 6KB
I Deskiop 1) 190403_000c.xyz M XYZFile 122K8

7 190403 _000c_GPS.xyz
7 190403_000nxyz

M XYZFile G6KB
M XYZFile 1KB

[Z) Documents

3 Downleads o i
’ 7] 190403.000n_GPSxyz M XVZFile 6KE
D Music " PostGPS 18z M XVZFile 24Ke
= Pictures 7 PostGPS19_1 M XYZFile OKB
RES
B videos 7 PostGRS18-1ayz M XVZFile 23K8

i Windows (C) v [z M XYZFile 24K8 v

File name: | PostGPS19 2xyz -

Save astype: | XVZ Files (“ayz) v

~ Hide Folders Cancel
Figure 3.18: Select Output File window

Select a file name and click the Save button. The Select XYZ File window will
close and the selected file name will be displayed beside the Output XYZ File
button in the Position Sensors Using External GPS File window.

When all three, Input RTmap31, Input GPS and Output files are specified the
Proceed button in the Position EM31-MK2 Readings Using External GPS File
becomes active (Figure 3.19).

Select EM31 Components and Select EM31 Dipole Mode

To select a data type (component and dipole mode) click on desired radio
buttons labeled Conductivity and Inphase, Conductivity, or Inphase in the
Select EM31 Component section and click on one of the radio buttons labeled
Vertical Dipole Mode or Horizontal Dipole Mode in the section Select EM31
Dipole Mode section. Both components Conductivity and Inphase are given as
a default. Data is always placed in the created XYZ file in the following order:
X coordinate (Easting or Longitude), Y coordinate (Northing or Latitude),

and selected component. If data type containing both components was selected
(Conductivity and Inphase in the Select EM31 Components section) then the
order is as follows: coordinates (as above), and Conductivity and Inphase for se-
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[I[] Position EM321 Readings Using External GPS File
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Figure 3.19: Position EM31-MK2 Readings Using External GPS
File window

lected dipole mode. This data may be followed by one more columns containing
Time Stamp if this option is selected (check box button located in the EM31-
MK?2 Separations section).

If parameter Header Info in Include in File section is checked a line listing all
parameters in the file will be placed as a header for each created XYZ file.

If the checkbox labeled Disable Automatic Dipole Mode Indication is checked
in the Select EM31-MK2 Dipole Mode section the program will ignore reading
dipole mode tags and it will write all data (within selected components) in XYZ
file, regardless dipole mode selection in the Select EM31-MK2 Dipole Mode
section.

This option may be very useful when the survey is performed using trailer
mounted instrument. In this case a dipole mode indicator in the instrument may
output false information due to strong vibrations caused by terrain obstruc-
tions. Therefore, while carrying survey with trailer or in harsh terrain in lets say
Vertical mode, it is possible to have some Vertical readings tagged as Horizontal
dipole mode reading.
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Type of Output File

Check the option appropriate for the contouring software used. The Generic
option will create a four or more column file without any text strings. This file
can be used as an input file for many contouring packages (including Surfer).
Geosoft format will cause the program to write a message LINE # at the begin-
ning of each survey line.

Include in File

This section contains two check boxes labeled Header Info and Field Com-
ments. When Header Info box is checked the file will contain a header listing
type of coordinates and names of channels contained in each column of created
XYZ file. Checking box labeled Field Comments will cause the program to
write text of all field comment (entered by the operator during the survey) in to
the created file.

GPS Time Gap

Differentially corrected GPS data often has gaps, due to differences in the con-
stellation of satellites visible to two (fixed and moving receivers), lack of beacon
signal, surveying near trees, buildings, and other elevated obstructions. These
gaps are filled by RTM31 with the assumption that the GPS receiver speed is
essentially constant and that it moves along a straight line during the gaps.

The GPS Time Gap parameter specifies the maximum time during which the
EM31-MK?2 data will be linearly interpolated between two GPS positions. Enter
this parameter (in seconds) in the edit box labeled seconds in the GPS Time
Gap section (Figure 3.19). In most cases a value 3 to 5 times larger than the
GPS data acquisition frequency is adequate, however the user has to determine
this value based on the survey specific conditions and requirements. To ignore
effect of this parameter enter a large number of seconds (i.e. 900 or more) as
GPS Time Gap parameter.

GPS Minimum Interval

The GPS Minimum Interval parameter specifies the minimal distance between
two GPS stations that will be used in interpolation. If this distance is smaller
than the specified GPS Minimum Interval, then all EM31-MK?2 readings located
between these two stations will be ignored. This parameter is useful in cases
when the operator stops for a moment and data are collected in one point.
Limited accuracy of GPS positioning will create randomly distributed positions
in area adjacent to the stationary location of the system. If RTM31 will calcu-
late positions of sensor in case offset values (GPS X and/or GPS Y Offsets) are
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different than zero, positions of the EM31-MK2 will have quite large varia-
tions associated with apparent change of direction of the survey line caused by
randomly close spaced GPS positions. In most cases a value 2 or 3 times smaller
than average distance between two GPS stations is adequate, however the user
has to determine right value for this parameter which will depend on survey
conditions and first of all accuracy of the employed GPS receiver. To ignore the
effect of this parameter and to use all stations during creating XYZ file (i.e.
during testing when GPS antenna is stationary) set this parameter to zero.

Enter the GPS Minimum Interval in the edit box and check one of the two radio
buttons labeled meters and feet (indicating distance unit) in the GPS Minimum
Interval section (Figure 3.19).

Format of the External GPS File

This section describes contents of the External GPS File. It is assumed that the
file is in ASCII (text) format, and columns are delimited by comma or spaces.
Parameters that have to be specified include: type of coordinates (UTM or Geo-
detic), identifying numbers of columns corresponding to each coordinate and
time, and indicating time of GPS data (UTC or satellite time). These param-
eters are necessary for RTM31 to correctly calculate positions of each sensor.

Post-processed GPS files in ASCII (text) format include UTM or Geodetic
(Latitude/Longitude) coordinates. To select coordinates click Geodetic or UTM
radio buttons (Figure 3.19). Geodetic coordinates, Latitude and Longitude are
given in degrees. The program assumes format DDD.DDDDDDDD. Format
DDMM.MMMMM (native format found in NMEA GPS messages) is not sup-
ported by this option of RTM31. UTM coordinates can be generated in meters
or feet. To select units for UTM coordinates click one of the radio buttons lo-
cated in the Units section located at the UTM radio button (Figure 3.19). These
radio buttons are active only when the radio button labeled UTM is selected.

Specify columns where each coordinate and time in text boxes labeled Column.
Valid format of the time is hh:mm:ss.

Check box labeled UTC/Satellite Time Lag must be checked and value in sec-
onds (default is 16s) specified if your GPS software is using Satellite Time to
time stamp positions. NMEA messages, and therefore RTmap31 data file con-
tains UTC time as a time of GPS reading. In most cases, if GPS logger is used to
save data the Satellite Time is used. Please refer to your GPS software manual.
Currently difference between UTC and Satellite clocks is 16 seconds.
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Creating XYZ Files With Positioned Readings

When all parameter are set and input and output file names are specified, the Proceed
button is activated in the Position Sensors Using External GPS File window. After you
click the Proceed button, the program begins to read input files, replaces GPS positions
by positions given in GPS file, calculates EM31-MK2 stations positions based on the re-
corded GPS readings, instant heading, and other specified parameters, and writes results
to the XYZ output file (or files depending on the Output Data setting). A progress bar
at the bottom of the screen shows the percentage procedure.

The speed of this operation depends on the size of input files. After the output XYZ file
is created a two dimensional layout of the survey is displayed (Figure 3.20).

The image displayed in the Plot XYZ window shows the spatial layout of stations to
scale, based on the station coordinates as written to the created file. The display has
fixed colours. GPS positions are marked by larger grey dots while the EM31-MK?2 sta-
tions are plotted by smaller red dots. This plot window can be closed by clicking on
Close button (located in the top right corner of the window).

After the Plot XYZ window is closed a button Replot Last Output File becomes active
and the layout of data can be examined again. However, at this time original GPS posi-
tions will not be displayed and all instruments will be represented by the same colour on
the screen. Files created by this portion of the program can be also viewed at any time
using the File | View XYZ File menu.

After the file is created and its layout is examined it is possible (if required) to recreate
XYZ file with changed system geometry parameters. To do this, click Edit Parameters
button, the Edit RT'map31 File Parameters window will appear again. After changes are
done, click the Proceed button to repeat procedure of creating XYZ file. See example
in Figure 3.21 where GPS antenna location was changed as compared to case shown in
Figure 3.20.

If the input file does not contain sufficient GPS information, contains different time
range, or parameters are not correctly selected, the program will display a warning mes-
sage.
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Figure 3.20: Two dimensional layout of stations taken with the Geonics EM31-MK2 and
GPS. The GPS antenna was located above the center of the EM31-MK2 sensor
(GPS X and Y offsets are set to zero).

Figure 3.21: Two dimensional layout of stations taken with the Geonics EM31-MK2 and
GPS. The GPS antenna was located off the center of the EM31-MK2 sensor
(GPS X offset = 1.0 m and GPS'Y offset =0).
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Convert Data Files

Convert menu of RTM31 program allows you to convert the RTmap31 binary file to other for-
mats. There are five items associated with the Convert menu (Figure 4.1):

e convert RTmap31 file to Geonics DAT31W (.G31) format,
e convert RTmap31 file to general format ASCII file,

¢ retrieve and position field comments from RTmap31,

¢ convert GXY file to ASCII file containing positions,

* correct system time constant delay in XYZ files.

St RTM31

File Position Readings %ﬂver‘t Data Files  Data Transfer Help

RTmap31 (T31) Files to Geonics (G31) Format
RTM31 Files to ASCIl Format

Retrieve and Position Field Comments
GXY File to XY (ASCIl) Format

Correct Time Constant Delay in XYZ File
[

-

Copyright © 2007-2018 Geomar Software Inc. -

Figure 4.1: Convert Data Files menu

Files converted to Geonics G31 format can be further processed by the Geonics DAT31W
program, while files converted to general ASCII format can be easily reformatted and used by
other software. While retrieving comments from RTmap31 file, the program retrieves text of the
comment and their position based on neighbouring GPS records. When converting GXY files
(containing only GPS positions and field comments) the program generates simple XY type of
file (coordinates in two columns with optional parameters). Correct Time Constant Delay item
provides correction for specified time constant delay of the system (EM instrument specific time
constant combined with GPS latency). Any XYZ file containing sequential time stamp column
can be corrected while using this option.
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It should be noted that three first items of Convert Files menu are disabled. They are enabled
automatically after the RTmap31 data file is loaded in File menu (Figure 4.2).

Yot RTM31 - X

File Position Readings gonvert Data Files Data Transfer Help
RTmap31 (T31) Files to Geonics (G31) Format
RTM31 Files to ASCI Format
Retrieve and Position Field Comments
GXY File to XY (ASCIl) Format
Local [Log § . .
Correct Time Constant Delay in XYZ File
Starter
Erded 003145735 || Ended 04430843
—Data File Contents———————  ~ Data File Settings
EM31 Readings: R204 EM3IT: Standard
GPS Positions: 927
Invalid GPS Data: 1] Distance Unitz: meters
Esternal Senzor Data: 0 GPS Message: GlGa
Survey Lines: 3 GPS ¥ Offset: 0
Comments: 1 GPS ' Offset 5
Wertical Mode rdgs: B204 Survey Mode: At
Harizontal Mode rdgs: 0 ExtSensar Type: Mane
Fiducial Markers: a GPS Elevation:  Available

Figure 4.2: Convert Data Files menu after RTmap31 file is loaded to
the program

Selected examples of file formats created by RTM31 are given in Appendix B of this manual.

4.1 Convert RTmap31 Data to Geonics DAT31W (G31) Format

The Convert RTmap31 to Geonics G31 Format option allows you to convert RTmap31
files to Geonics DAT31W format. Select Convert| RTmap31 to Geonics G31 Format
from the main program menu, as shown in Figure 4.2.

After the selected menu item is clicked the Convert RTmap31 Files (T31) to Geonics
G31 Format window will be displayed in the centre of the screen, Figure 4.3.
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Convert RTmap31 Data to Geonics G371 Format

Output File [G21] |

Output Diata
v Include GPS Positions

v Include Comments

Wiew Converted File

Cancel |

Figure 4.3:  Convert RTmap31 Files to Geonics G31 Format

Parameters in Convert RTmap31 Data to Geonics G31 Format Window

Several parameters which affect the contents and format of the created output (G31)
file must be specified. The first is Output File name. Output Data parameters if checked
cause the program to write GPS positions, Comments entered in the field. Time Stamp
for each reading is included automatically.

Output File (G31)

Click on the Output File (G31) button. The Select Output File window is dis-

played (Figure 4.4).

Select Output File X

A [ > ThisPC 5 Windows (C)

Organize v New folder

RT31_data A Name

Rrmap31 [ 050617.011.931

OneDrive [ 050617_009.931

5 120334 911.931

B This e [ 122100_001.931
30 Objects El 1895931

i, Windows (C) v

» Data » RTmap3l » 20181212 TestFiles

~ @] | Search 20181212 TestFiles »

Type
G31File
G31File
631 File
631 File
G31 File

B=

Size

302KB
302KB
202K8
202KE
302KB

File name: | 180708_001]

Save as type: | Geonics EM31 Files (*.G31)

A Hide Folders

[

Cancel

Figure 4.4:  Select Output File window

Select a file name and click the Save button. The Select Output File window will
close and the selected file name will be displayed beside the Output File (G31)
button in the Convert RT'map31 to Geonics G31 Format window.

When Output file is specified the Convert button in the Convert RTmap31 to

Geonics G31 Format window becomes active.
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Output Data

RTM31 can generate a file with EM31-MK2 data as recorded by RTmap31 data
acquisition program. The file may also contain GPS positions and Comments.
Check appropriate check boxes in section labeled Data Output. GPS positions
are properly written in Geonics DAT31W format regardless which GPS message
was used during the survey.

Converting RTmap31 Data to Geonics DAT31W (G31) Format

When all parameters are set and input and output file names are specified, the Convert
button is activated in the Convert RT'map31 File to Geonics G31 Format window. After
you click the Convert button, the program begins to read the input file, converts data to
DAT31W format and writes results to the output file. A progress bar at the bottom of
the screen shows the percentage of the file read (Figure 4.5).

Convert RTmap31 Data to Geonics G31 Format

Output File [G31) | IE:\Data\HTmap31 %20181212_TestFiles\180708_001.931

Output Data
¥ Include GPS Positions Yiew Corverted File Convert
¥ Include Conmmerts Cancel | Exit

Figure 4.5: Convert RTmap31 Files (T31) to Geonics G31
Format window during data processing

The speed of this operation depends on the size of the input file. After the output (G31)
file is created the View Converted File button becomes active. Clicking on this button
will display first 63 Kbytes of the created file.

The created file can be loaded to the Geonics DAT31W program. It should be noted
that the created file contains original GPS positions, without corrections for GPS X and
Y Offsets specified during the survey.

Clicking Cancel button will clear text box at Output File (G31) button. Click on Exit but-
ton to close the Convert RT'map31 Files (T31) to Geonics G31 Format window.

An example of data file in Geonics DAT31W (G31) format is given in Appendix B.
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4.2 Convert RTmap31 Data to ASCII Format

The Convert RTmap31 Data to ASCII Format option allows you to convert RTmap31
binary files to ASCII format, which can be viewed with any text editor and then eas-
ily converted to the other format. Select Convert | RTmap31 to ASCII Format from the
main program menu, as shown in Figure 4.2.

After the selected menu item is clicked the Convert RTmap31 Files to ASCII Format
window will be displayed in the centre of the screen, Figure 4.6.

Convert RTmap31 Data to ASCIl Format

Output File |

Format of GPS Pozsitions:
Geodetic———————— ~UTM [wWG584) Original MMEA Message Convart
r‘ D0D.0DDDDDDD © meters & NMEA . :
r‘ DODMM MMM " feet i File
feet
I

i

115 Survey

Cancel

Format of External Sensor - Not Available ‘

¥ Include Ext. Sensar " Interpreted Data % Original Formnat Exit

Figure 4.6:  Convert RTmap31 Files to ASCII Format window

Parameters in Convert RTmap31 Data to ASCII Format Window

Several parameters which affect the contents and format of the created output (ASC)
file must be specified. These are the ASCII file name, and Format of GPS Positions (co-
ordinates format or original NMEA statement). The External Sensor option is not used
in this version of the program.

Output File
Click on the Output File button. The Select Output File window is displayed
(Figure 4.7).
Select a file name and click the Save button. The Select ASC Output File win-

dow will close and the selected file name will be displayed beside the Output
File (ASC) button in the Convert RTmap31 Files to ASCII Format window.

When Output file is specified the Convert button in the Convert RI'map31 Data
to ASCII Format window becomes active.
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Select ASC Output File

+ > ThisPC > Windows(C) > Data » RTmap31 > 20181212 TestFiles | @ | Search 20181212 TestFiles »

Organize v New folder = @
R3ldata A Neme Type Size
Rlmap31 313,85 5PM  ASCFile 031 k8

OneDrive 1) A345_02.a5c M ASCFile 931 k8
7 asiz.ase M ASCFile 921 k8
[ This pC “ocasc M ASCFile 566 KB
B 30 Objects
I Desitop
[ Documents
- Downloads
D Music
&= Pictures
B

dows (C) v

File name: | 5130702 001 ~

Save as type: | ASCII Files (.ASC) ~

A Hide Folders Cancel
Figure 4.7:  Select ASC Output File window

Format of GPS Positions

Positions can be written in the output file as geodetic (geographical) coordinates
(Latitude/Longitude), they can be converted to UTM coordinates, or written to
file as original NMEA messages (exactly as streamed by a GPS receiver). The
program uses the WGS1984 datum. To select coordinates click the appropriate
radio buttons in the sections labeled Geodetic or UTM (Figure 4.6).

Geodetic coordinates, Latitude and Longitude are given in degrees. They can
be written in two formats DD.DDDDDDDD or DDMM.MMMMM (native
format found in NMEA GPS messages). To select which format click the appro-
priate radio button in the section labeled Geodetic (Figure 4.6).

UTM coordinates can be generated in meters, feet or US Survey feet. To select
units for UTM coordinates click one of the radio buttons located in the Units
section located at the UTM radio button (Figure 4.6).

Converting RTmap31 Data to ASCII Format

When all parameter are set and output file name is specified, the Convert button is
activated in the Convert RTmap31 Data to ASCII Format window. After you click the
Convert button, the program begins to read the data, converts data to ASCII format and
writes results to the output file. A progress bar at the bottom of the screen shows the
percentage read (Figure 4.8).
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Convert RTmap31 Data to ASCIl Format

Output File | IC:'\Data\HTmap31 YW20181212_TestFiles\S180708_001 asc
Format of GPS Positions ;
Geodetic—————— ~ UTHM [WGE584) Original MMEA Message k

¢ DDD.DDDODDDD  meters F NMEA -
£ DDDMM MMM " feet i |
U5 Survey feet
Cancel |

Exit |

Format of External Sensor - Mot Available
’V ¥ Include Ext Sersor € Interpreted Data = Original Formnat ‘

Figure 4.8:  Convert RTmap31 Files to ASCII Format window
during data processing

The speed of this operation depends on the size of the input file. After the output file
is created the View Converted File button becomes active. Clicking on this button will
display first 63 Kbytes of the created file.

The created file contains EM31-MK2 readings, GPS positions, and entire information
related to the instrument and survey settings. Example of the output file in ASCII for-

mat is given in Appendix B.

Clicking Cancel button will clear text box at Output File button. Click on Exit button to
close the Convert RTmap31 Data to ASCII Format window.

4.3 Retrieve and Position Field Comments

The Retrieve and Position Field Comments option allows you to convert retrieve field
comments from RTmap31 binary files. At the same time the program assigns GPS posi-
tions to indicate where these comments were entered by the operator. The position can
be assigned either as a GPS position preceding or position following the comment entry.
The resulting output file consists of coordinates and corresponding text of the comment.
Select Convert | Retrieve and Position Field Comments from the main program menu, as
shown in Figure 4.2.

After the selected menu item is clicked the Position Comments Recorded in RTmap31
File window will be displayed in the centre of the screen, Figure 4.9.
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Position Comments in RTrmap31 Data File

QutputFiIe[TXT]! |
Coordinates Forridt (w15 584)

Comment Position at

Geodetic UTM

' DDD.DDDDDDDDD ; meters & Last GPS Pasition
feet

" DDDMM. MMM bR 1S Survey feet  Nest GPS Position

Cancel

Exit

Yiew Fila |

Eroceed

Figure 4.9:  Position Comments in RTmap31 Data window

Parameters in Position Comments Recorded in RTmap31 File Window

Several parameters which affect the contents and format of the created output (TXT)
file must be specified. These are the output file names, coordinates format, and indicat-
ing type of position of the comment - using a preceding or following GPS reading.

Output File (TXT)

Click on the Output File (TXT) button. The Select Output File window is dis-
played (Figure 4.10).

Select Output File X

+ > ThisPC > Windows(C) > Data » RTmap31 > 20181212 TestFiles | @ | Search 20181212 TestFiles »

Organize v New folder =~ @

RT31_data “~ Neme Type Size

RTmap31 [E cmsz_oam Text Document K8
|5 crm ot
B e
[ERe

|5 Commento2t

OneDrive
Text Document 1KB

Text Document t 1k
Text Documen t 1B

[ This PC

B 3D Objects
B Desktop
Documents
¥ Downloads
D Music

=] Pictures
B Videos

i Windows (C) v

File name: | C7732 0ot v

Save 25 type: | XY Comment Files (*.TXT) ~

A Hide Folders

Figure 4.10: Select Output File window

Select a file name and click the Save button. The Select Output File window will
close and the selected file name will be displayed beside the Output File (TXT)
button in the Position Comments Recorded in RT'map31 File window.
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When both, Input and Output files are specified the Proceed button in the Posi-
tion Comments Recorded in RTmap31 File window becomes active.

Coordinates Format

Positions can be written in the output file as geodetic (geographical) coordi-
nates (Latitude/Longitude) or they can be converted to UTM coordinates. The
program uses the WGS1984 datum. To select coordinates click the appropriate
radio buttons in sections labeled Geodetic or UTM (Figure 4.9).

Geodetic coordinates, Latitude and Longitude are given in degrees. They can
be written in two formats DD.DDDDDDDD or DDMM.MMMMM (native
format found in NMEA GPS messages). To select which format click the appro-
priate radio button in section labeled Geodetic (Figure 4.9).

UTM coordinates can be generated in meters, feet or US Survey feet. To select
units for UTM coordinates click one of the radio buttons located in the Units
section located at the UTM radio button (Figure 4.9).

Comment Position at

This section specifies how GPS positions are assigned to the comment. There
are two choices: Comment can be assigned to the last position that was recorded
by the RTmap31 program, or to the position that follows comment entry. In
most cases any choice is right since comments are usually taken while collect-
ing data (including GPS positions) and during comment entry operator stops
recording for a moment. However the option Last GPS Position appears to be
more natural since after the comment entry the operator may stop taking read-
ings and later continue survey from other location.

To select comment position option click one of the radio buttons labeled Last

GPS Position and Next GPS Position located in the Comment Position at sec-
tion of the window (Figure 4.9).

Positioning Comments Recorded in RTmap31 File

When all parameter are set and input and output file names are specified, the Proceed
button is activated in the Position Comments Recorded in RTmap31 File window. After
you click the Proceed button, the program begins to read the input file, converts data to
ASCII format and writes results to the output file. A progress bar at the bottom of the
screen shows the percentage read (Figure 4.11).
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Paosition Comments in RTrap31 Data File

[EEEECE]

Output File [TXT) |c: \DataWRT mapal S201 51 212_T esthileshC77a2_ 05k

Coordinates Format [WiE584) Comment Pozition at
Geodetic UTH
{* DOD.DODODDODD ; meters & Last GPS Position
feet
" DDDMM. MMM bbb LS Survey feet " Newt GPS Position

1 Comments Found Cancel | Exit iew File |

Figure 4.11: Position Comments Recorded in RTmap31 File
during data processing

The speed of the operation depends on the size of the input file. After the output file is
created the View File button becomes active. Clicking on this button will display first 63
Kbytes of the created file.

The created file contains GPS positions in the first two columns followed by the text of
comment as recorded in the field. Example of the output file containing comments is
given in Appendix B.

Clicking Cancel button will clear text boxes at Input File (T31) and Output File (TXT)
buttons. Click on Exit button to close the Position Comments Recorded in RTmap31
File window.

4.4 Convert GXY Files to XY (ASCII) Format

Files GXY are created by the RTmap31 when only GPS data are collected (EM31-MK2
is Disabled). This type of file contains GPS positions and optionally field comments. The
Convert GXY File to XY (ASCII) Format option allows you to convert GXY binary

file to simple XY type of file. This file contains coordinates placed in first two columns
with optional field comments, elevation, UTC time, local time, and GPS station number
located in following columns. All parameters are always placed in above order. This for-
mat can be viewed with any text editor and it can be easily converted to other formats.

It should be noted that GXY files created with any other Geomar data acquisition pro-
grams (i.e. ML61MK2, NAV61MK2, RTmap38, NAV38, etc.) can be converted to ASCII
format using this option of RTM31.
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Select Convert| GXY Files to XY (ASCII) Format from the main program menu, as
shown in Figure 4.1. After the selected menu item is clicked the Convert GXY File to
XY Format window will be displayed in the centre of the screen, Figure 4.12.

DD Convert GXY or Data File to XY Format

Output File [DAT)

— Coordinates Format [0 atum *WGS 1984)—————————— [~ File Contents
Geodetic UTH 0 MNumber of Spaces in
« pOD.ODDDDDDDD  meters Front of Each Recard
" DDDMM. MMM i M Include Field Comments
7 US Survey feet
[ Include Elevation Data
— Elevation W Include UTC (GPS) Time
Elewation Units GPS Antenna Height and Units ™ Include Local Time
[meters ~| oo [meters -] ™ Include GPS Stn Number

¥ Average Positions at GPS stations [if applicable)
I

G=Y, RTmap, and all M&Y data files, az well as MLET, MLETMEZ, and ML31 data can be processed

Cancel | Ezxit | EiewFilel Proceed

Figure 4.12: Convert GXY Files to XY Format window

Parameters in Convert GXY to XY Format Window

Several parameters which affect the contents and format of the created output (DAT)
file must be specified. These are the input and output names, Coordinates Format, and
contents of the output file.

Input File (GXY)

Click on Input File (GXY) button. The Select GXY Input File window is dis-
played (Figure 4.13).

The window lists files with extension name GXY. Select a file name and click
the Open button. The Select GXY File window will close and the selected file
name will be displayed beside the Input File (GXY) button in the Convert GXY
File to XY Format window.
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[1] Select GXY, RTmap31, or any other NAV or RTmap Input File

4 [ > ThisPC > Windows(C) > Data » RT31_data v @ | Search RT3 data »
Organize New folder = ™ @
20190513 .Dow *  Name Date modified Type Size @
RT31_data [ 050412H.6XV 2004-05-0411:30 .. GXV File a8
RTmap31 | ] 122816D.GxXY. 2001-12-28250PM  GXY File 35kB
OneDrive [ 120625_000.731 31 File aKe

=1 180625 001.731
[ This PC =l 180625_002.731

T31File 237KB

31 File 358
8 3D Objects [ 180625003731 31 File 18K8
B Desktop =) 180625_004.T31 31 File 21k8
Bocuments [ 120625_005.731 31 File 483 KB
3 Devrioas [ 120702000721 31 File 22k8

[ 180708_001.731 31 File 24k8
b Music [ 120708_002.731 31 File 520K8
=] Pictures 5 120708 003731 T31 File 1,008 KB
8 videos [ Mm1.6xy GXY File 3KB
. Windows () [ mmz.gxy GXY File 3Ke

v [ Mmsaxy G File 17k8 v
File name: 122816,/ v | 6% and Rmap31 Files (~6x, v

Figure 4.13: Select GXY Input File window

Output File (DAT)

Click on the Output File (DAT) button. The Select Output File window is dis-
played (Figure 4.14).

[T Select Output File ’

A [ » ThisPC » Windows(C) » Data » RT3 data v &/ | Search RT31_data 2
Organize v New folder =~ ()
RT31_data A Name Date modified Type Size
RTmap31 3 225 1 dat

OneDrive ) mizss.dat
) mmm2.dat

DAT File 9KB
DAT File 9K
DAT File 9KB

O ThisPC
8 3D Objects
[ Desktop
Documents
& Downloads
D Music
] Pictures
B videos
‘i Windows (C) v

File name: | A2266_1] ~

Save astype: XV Files ("DAT) ~

[
A Hide Folders Cancel
Figure 4.14: Select Output File window

Select a file name and click the Save button. The Select Output File window will
close and the selected file name will be displayed beside the Output File (DAT)
button in the Convert GXY File to XY Format window.

When both, Input and Output files are specified the Proceed button in the Con-
vert GXY File to XY Format window becomes active.
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Coordinates Format

Positions can be written in the output file as geodetic (geographical) coordinates
(Latitude/Longitude) or they can be converted to UTM coordinates. The pro-
gram uses the WGS1984 datum. To select coordinates click appropriate radio
buttons in sections labeled Geodetic or UTM (Figure 4.12).

Geodetic coordinates, Latitude and Longitude are given in degrees. They can
be written in two formats DD.DDDDDDDD or DDMM.MMMMM (native
format found in NMEA GPS messages). To select which format click the appro-
priate radio button in section labeled Geodetic (Figure 4.12).

UTM coordinates can be generated in meters, feet or US Survey feet. To select
units for UTM coordinates click one of the radio buttons located in the Units
section located at the UTM radio button (Figure 4.12).

File Contents

This section affects the output file format and contents. It contains one text box
labeled Number of Spaces in Front of Each Record and five check boxes labeled
Include Field Comments, Include Elevation Data, Include UTC (GPS) Time,
Include Local Time, and Include GPS Stn Number.

Number entered in the text box will specify number of spaces in front of each
record. This option may be useful while using created files as control files in
mapping software. To ignore this option enter zero.

Checking box labeled Include Field Comments will cause the program to write
text of all field comment (entered by the operator during the survey) in to the
created file.

The Include Elevation Data option allows you to place elevation values in the
created file. When this option is checked then a set of options in the frame
labeled Elevation is enabled.

When Include GPS Time box is checked the program will write a column con-
taining time of GPS position, and if the Include Local Time box is checked local
(field computer) time will be written to the file.

When the Include GPS Stn (station) Number is checked then sequential GPS
station will be placed in the file. If averaging was used during GPS data collec-
tion (and check box Average Positions... is not checked) then several recorded
GPS positions may have same station number.
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Elevation

If Elevation check box is checked then window controls associated with Eleva-
tion are enabled. Please select units for elevation values (these can be meters,
feet, or US Survey feet). To obtain ground elevation values please specity GPS
antenna height and units that were used to measure height of the antenna.

Average Positions at GPS stations

This option can be used only if the similar option is provided in RTmap31.

If averaging was used during GPS data collection and the check box labeled
Average Positions at GPS stations is checked then the program will calculate av-
eraged position from all readings taken at each station and one resulting value
will be written to the file. When the check box is not checked then all recorded
positions will be placed in the file.

Converting GXY File to XY (ASCII) Format

When all parameter are set and input and output file names are specified, the Proceed
button is activated in the Convert GXY to XY Format window. After you click the
Proceed button, the program begins to read the input file, converts data to ASCII format
and writes results to the output file. A progress bar at the bottom of the screen shows the
percentage read (Figure 4.15).

[T Convert GXY or Data File to XY Format

Input File [GY] | IC: WDatah AT 31 _datah 1228160 .Gy

Qutput Fils [DAT) |c: \DatahAT 3 _data®A2266_1.dat

— Coordinates Format (D atum WGS 1984)—————————— [~ File Contents

Geodstic UTM Mumber of Spaces in
¢ DDD.DODDDDDDD " meters Front of E ach Record
" feet

7 DDCMM. MM bbb M Include Field Cormments
% US Survey feet
W Include Elevation Data
— Elevation ¥ Include UTC (GPS) Time
Elevation Units GPS Antenna Height and Units [7 Include Local Time
-

|metels j |‘I 25 |metels j

Include GPS Sth Hurmber

v Average Positions at GPS stations [if applicable)

52 Exclims Cancel | Eit | wiewFie |

Figure 4.15: Convert GXY Data Files to XY Format window
during data processing
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The speed of this operation depends on the size of the input file. After the output file is
created the View File button becomes active. Clicking on this button will display first 63
Kbytes of the created file.

The created file contains GPS positions as recorded in the field. Example of the output
file in ASCII format is given in Appendix B.

Clicking Cancel button will clear text boxes at Input File (GXY) and Output File (DAT)
buttons. Click on Exit button to close the Convert GXY Files to XY Format window.

4.5 Correct Time Constant Delay in XYZ File

This option allows for the system time constant delay correction. The procedure acts on
two dimensional, GPS positioned data.

While the EM31-MK2 time constant is known (approximately 0.5 s) the time constant
of the combined EM31-MK2 and GPS receiver system is a function of these two de-
vices. The easiest method to determine the time constant of the system is to survey a
known buried pipe. After the proper time constant delay correction is applied the linear
anomaly associated with the pipe should be free of any “hearing bone” effect. Another
method to determine the time delay is to survey a few lines (in two directions) with vary-
ing speeds over the same small metallic target. When displaying the image the anomaly
associated with the sample target may be slightly displaced or extended in size on neigh-
boring lines. After the correct time constant for the system is determined the anomaly
should be at the same location for each survey line.

Since the image of two dimensional data can be displayed in a mapping system (after
griding) the procedure can be time consuming, however it only needs to be done once
for a given GPS receiver and EM31-MK2.

In order to apply the correction the generated XYZ file must have time stamps. In the
event input file does not have time stamp at each reading the program will display a
warning message.

The correction acts on any XYZ type of file so care should be taken that data is not cor-
rected twice.

To access this option select Convert | Correct Time Constant Delay in XYZ File in the
menu (Figure 4.1). The Correct Time Constant Delay window will appear on the screen
(Figure 4.16).
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[”] Rtm31 Correct Time Constant Delay in XYZ File

Input File I
Output File | I
. Coordinates in v File————
Systemn Time Constant I 0.7  seconds & UITM [meters or fest)
t arimurm Gap between Readings I 10 seconds " Geodetic [LATALOM)
|
Select Input and Output Files Ermea Bdi

Figure 4.16: Correct Time Constant Delay in XYZ File window

Parameters in Correct Time Constant Delay Window

Several parameters which affect the contents of the created output (XYZ) file must
be specified. These are the Input and Output XYZ file names, System Time Constant,
Maximum Gap between Readings, and type of coordinates in the input XYZ file.

.
Input File
. . . . . .
Click on Input File button. The Select Input XYZ File window is displayed
(Figure 4.17).
&« v 4[> ThisPC » Windows (C) > Data > RT31_data v ©| | SearchRT3_dats »
Organize »  New folder = M @
20190513Dow ~  Name - Date modified Type Size 2
RT31_data 1120625_a gz 20 XVZ File 201 kB
RTmap31 ) 180625_a_GPSixyz XYZ File 21kB
OmeDrive ) 120708 002022 XVZFile 2168
"] 180708_0025a_GPSayz 20 3. XVZFile 28
& ThisPC 7 180708 0033z 2019-05-0911:31...  XYZFile 460 KB
B 30 Objects 7] 120708_003_GPS.xyz 20 31..  XVZFile a7ke
B Desktop ) 1809172 9.. XVZFile 180 KB
Bocuments ) 120917 6Pz 9.. XVZFile 19K8
1) 130403_000.xy2 3PM  XVZFile 1228
¥ Downloads =
7] 190403_000_GPSuxyz 8PM  XYZFile 6KB
I musie ) 190403 000cayz 9PM  XVZFile 122¢8
[ Pictures ) 130403_000c_GPSxyz 9PM  XVZ File 6KB
H videos 7 190403_000nayz 1PM XVZFile k8
£ Windows (G 77 190403_000n_GPSaxyz 20 1PM XVZFile 6ke
v ) A2sdet 2019-05-17445PM  DAT File 5 9B v
File name: |wm7os,m3.xyz v| [ XVZ Files (~XVZ, ~DAT, ~ASC) v

Figure 4.17: Select Input XYZ File window

The window lists files with extension names XYZ, DAT, and ASC. Select a file
name and click the Open button. The Select Input XYZ File window will close
and the selected file name will appear next to the Input File button in the Cor-
rect Time Constant Delay window.
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Output File

Click on the Output File button. The Select XYZ File window is displayed
(Figure 4.18).

[T Select Output XVZ File

e © 4 s ThisPC » Windows(C) > Data > RT31data v &/ | Search RT31_data £
Organize v New folder Ev @
RT31_data A Name - Date modified Type Size ~
RTmap31 7 180625_axyz XVZ File 201 k8
OneDrive 7] 180625_2_GPSayz XVZFile 218

) 120708_002aa.xyz
7 180708_002aa_GPSayz

XVZ File 216KB

3 his PC KVZ File 2k8

B 3D Objects ) 180708 0032 XYZ File 460 KB
B Desktop "] 120708_003_GPS.xyz XVZFile 478
[5] Documents 0 18091702 XVZ File 180KB
& Downloads MJ« 130917_GPS.yz XVZ File 16 KB
D Music 21 19040300007z XVZ File 122K8

7] 190403 _000_GPS.xyz
) 190403_000c xyz
B videos ) 190403 _000c_GPSxyz
‘i Windows (C) v (7] 190403 000nayz

XYZFile 6KB
XVZ File 122K8
KYZ File 6KB
M XVZFile 1KB v

&1 Pictures

Saveostype: | XVZFi

o s oz
Figure 4.18: Select Output XYZ File window

As a default the Input File name with prefix C is given. Accept the default, en-
ter, or select a file name and click the Save button. The Select Output XYZ File
window will close and the selected file name will be displayed beside the Output
File button in the Correct Time Constant Delay window.

When Input and Output files are specified the Proceed button in the Correct
Time Constant Delay window becomes active (Figure 4.19).

System Time Constant

Time delay 0.7 seconds is given as a default. This value can be changed (0 to 2
seconds), however the user should experiment before choosing a final value.

Maximum Gap Between Readings

This parameter specifies the maximum time during which the EM31-MK2 data
will be treated as continuous data set. If the gap between two stations is larger
than specified maximum gap the station that follows the gap will be assumed the
first station of a new line.

Enter this parameter (in seconds) in the edit box labeled Maximum Gap be-
tween Readings. In most cases a value 2 to 3 times larger than the GPS acquisi-
tion frequency is adequate.
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Coordinates in XYZ File

Specity type of coordinates in the input file. The output file will be written with
the same type of coordinates.

Creating XYZ File With Time Delay Corrections

When all parameter are set and input and output file names are specified, the Proceed
button is activated in the Correct Time Constant Delay window. After you click the
Proceed button, the program begins to read and analyze the input file. A label Analyzing
File is displayed at the bottom of the window. The program then calculates corrections
for each station based on the instant velocity of the system at each station. A progress
bar at the bottom of the screen shows the percentage read (Figure 4.19).

DD Rtrn31 Correct Time Constant Delay in XYZ File

Irput File | IE:\Data\HT31_dala\1BD?DB_DDS.H_I,JZ
Output File | IE:\Data\HT31_data'\E1BU?EIB_DEIEXYZ

System Time Constant I 0E5  seconds "Cnordlnales 55

& |ITH [meters or feet)
" Geodatic [LATALOM)

t axirum Gap between Readings I 10 seconds

Calculates comections. ..

Exit

|
Figure 4.19: Correct Time Constant Delay in the XYZ File
window during data processing

If the input file does not contain time stamp information, the program will display a
warning message, and it will pause operation till the OK button is clicked in the warning
window.
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RTmap31 Data File

A.1 Description of RTmap31 Data File Format (T31)

Each record created by the RTmap31 for MS Windows 10/7 program contains 27 charac-
ters, including line feed at the end of each record.

Header of the file contains 5 records starting with characters R, H, and then three

records starting with G.

2 3 4 5 6 7 8§ 910101112

13 14 15 16 17 18 19 20 21 22 23 24 25 26 17

|
RTM3 I W 2 0 0 |SurveyType |UT[ID|IM[IC|ST LT svid |10
H Data File Name Time Inc./Samples G svid |10
G| GPSXOffset (F7.2) GPS'Y Offset (F7.2) GP|GS|GR svid |10
G Initial Easting (F14.3) N 10
G Initial Northing (F14.3) 10
RTM31 - identification of program file, if rTM31
(lower case r) is present later in the file, it
indicates start of appended file header
W200 - version number (V2.00)
Survey Type - GPS (if GPS Input Enabled) or GRD (grid)
UT - unit type (0 = meters, 1 = ft, 2 = US Survey ft)
ID - EM31 Dipole Mode (selected by operator)
(0 = Vertical, 1 = Horizontal, 2 = Both)
IM - EM31 survey mode (0 = Auto, 2 = Manual)
IC - EM31 component (=0 Both, =1 Inphase)
ST - EM31 type (0 = Standard 3.66 m, 1 = Short 2 m)
LT - computer type (fixed =1 MS Windows)
svid - logger/software type id (not used)
Data File Name - file name, maximum 10 characters
Time/Samples - this field depends on EM31 survey mode

Auto Mode - Time Increment in seconds
Manual Mode - Samples/Reading

Appendix A. RTmap31 Data File
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TG - File tag (space=original, 1=Saved As / edited)

GPS X Offset - Offset of GPS antenna in X direction
GPS Y Offset - Offset of GPS antenna in Y direction
GP - type of GPS NMEA message

(0 = GGA/GSA, 1= GGA, 2 = POS, 3 = LLK,
4=LLQ, 5=GLL, 6 = GGK, 7 = RTS pseudo-GGA)

GS - GPS state (O=disabled, 1=FEnabled, >1 indicates
averaging number for GXY files)

GR - GPS update rate (= 0, fixed, not used)

Initial Easting - survey start coordinate (program internal use only)

ZN - UTM Zone (program internal use only)

Initial Northing - survey start coordinate (program internal use only)

10 - Line Feed character

Header at the start of survey line (contains four records starting with L, B, A, and Z)

23 45 6 7 8 9 1000 12 13 14 05 06 17 18 19 2021 22 23 24 25 26 17

|
L | Line Name - 8 characters 10
B Start Station (Format F11.2) 10
A |Dir Station Increment  (Format F11.3) 10
ZIDDMM Y Y Y Y HH : MM : S S . h h 10

Line Name - Line Name, maximum 8 characters

Start Station - Start Station for the Line, format F11.2

Dir - Direction of the Line (E, W, N, or S)

Station Inc. - Station Increment, format F11.3

Date - Date when Line was created, format DD-MM-YYYY

Time - Time when Line was created, format HH:MM:SS.hh

10 - Line Feed character

Timer Reset

12 3 4 5 6 7 8 9 0011 12 13 14105106 17 18 19 20 21 22 23 24 25 26 27

* | Computer Time (Format HH:MM:SS.hh) Time Stamp in ms (10 digits) 10

Indicates reset time of the program timer. This record links timer in millisec-
onds and computer time (local time) in format HH:MM:SS.hh. This record is
written to the file each time after the program switches from the Stand By to
Log mode. In case when data are taken continuously the timer is automatically
reset every hour.
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Reading
123 45 6 7 8 9 101012 13 1415 16 17 1819 2020 2223 2425 2 127

I [Gn Reading 1 Reading 2 Time Stamp in ms (10 digits) 10

I indicator T or 2

- first reading at the EM31 station (default for Auto mode)
- second reading at station (possible only in Manual mode)
Gn - information byte, one character parameter,

the ASCII number of this character indicates following:

N g

Bit Decimal Value and Meaning
7 128 1 not used
6 64 Marker =1 trigger pressed
= 0 otherwise
5 32 Mode =1 Vertical
Horizontal
4 16 0 not used
3 8 0 not used
2 4 Range 3
1 2 Range 2
0 1 0 not used

Range 3 and Range 2 represent sensitivity (gain) as follows

Both Components (OPER mode)

Sensitivity = Range 2 Range 3 Multiplication Factors
1000 1 1 Conductivity -0.25
100 0 1 Conductivity -0.025
10 1 0 Conductivity -0.0025

Multiplication factor for Inphase is the same for all ranges: =0.025

Both Components (COMP mode)

Sensitivity Range2  Range3 Multiplication Factors
1000 1 1 Inphase -0.0625
100 0 1 Inphase -0.00625
10 1 0 Inphase -0.000625

Conductivity is not recorded in COMP mode.
Multiply Reading by above factors to obtain reasult in mS/m or ppt.
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Reading 1 five character field containing instrument output. Conductivity

if Both components, Inphase if Inphase was selected

includes sign (+ or -) and four digits

Reading2 - five character field containing instrument output. Inphase if
Both components, not used if Inphase was selected
includes sign (+ or -) and four digits

Time Stamp- time in ms from the Windows start (resets every 49.7 days).
The time in milliseconds can be linked with the computer local

time by using Times in line started by * (see Timer Relation).

10 - Line Feed character
Comment
203 4 5 6 7 8 9 10001213 1415 16 17 1819 2021 22 23 24 25 26 17
C Comment (maximum 15 characters) Time Stamp in ms (10 digits) 10
New Station
23 45 6 7 8 9 00701 12 13 1415 16 17 18 19 20 21 22 23 24 25 26 U
S New Station (Format 11.2) Time Stamp in ms (10 digits) 10
Internal Readings
23 4 5 6 7 8 9 1011 1213 1415 16 17 18 19 20 21 22 23 24 25 26 77
{la Internal Position of an Element (Format 14.3) Time Stamp in ms (10 digits) 10
These records (curly brackets) are used only internally during data collection to speed
up map re-drawing in real time.
Records starting with X
Several informative records, for example X$STARTED indicates start of Logging mode,
X$PAUSED indicates Pause (activated by Pause key stroke), etc.
GPS Data Message Records
Each GPS record (GGA or other NMEA message) is broken in to several 25 characters
strings and placed in the RTmap31 data file which contains 27 characters records, includ-
ing one character indicator and line feed at the end of each record. The GPS sequence
starts at the line which contains the character @ as the first character, then records
that contain a continuation of the same message start with the character #. The GPS
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sequence ends with a line starting with the character !. The last line contains sequential
number of GPS recorded position and a logger time stamp for the given GPS reading. A
sample of the GPS message (GGA example) written in RTmap31 format is given below.

23 45 6 7 8 910

112 13 14 15 16 17 18 19 20 21 22 23 24 25 26 1]

(t]? $|{G|P|GIG|A|, |h|h|m|m|[s|s]|.|s]|s ]|, |d|d[m[m]|. [m]|m][m]l0
#Im|m|, |s|, |d|d|d|m|m mim{m{m|m|,|s|,|n|,|qlql,]|p]|10
#ip|.|p|,|slalalalalal.|alal|l,lul,|+]|x]|x|x|x|.|x|,|M]|10
#|,|s|s|s|,|alala|*|c]|c|CRILF 10
1{0]0|4|3]5 Time Stamp in ms (10 digits) 10

The GPS sequence may contain 4 to 7 records. The components of the GGA message
may differ in length, however they are placed in the same number of columns. Refer to
Appendix B (section B.2) for the definition of each component of the GGA data mes-
sage. Other available GPS messages in NMEA format, GSA, POS, LLK, LLQ, GLL,
and GGK, are recorded similarly. The structure of these NMEA sentences is given in
section B.2 of Appendix B.

If the Checksum in NMEA message is invalid then starting character @ is replaced by ?,
and # is replaced by " (ASCII character code 34). The starting character of Time Stamp
record ! remains the same.
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A.2 Example of RTmap31 Data File

RTM31 W200GPS00000 1

H180625 002 0.200 0

G 0.000 0.500 7 11 101
G 610730.497 17 B2E
G 4829891.531

Ll

B 0.00

AE 1.000

725062018 23:36:14

*23:36:14.004 1073216906
X$SSTARTED 1073218531
@SGPGGA,035214,4336.8268,N
#,07937.6649,wW,8,08,2.0,19
#0.0,M,-35.4,M,,*7

1000001p 1073219453
0.0001073219453
@SGPGSA,A,3,10,13,15,20,21
#,24,27,32,,,,,3.6,2.0,3.0

o

#*3

1000001 1073219609
Tu-2108-2112 1073221000
Tr-2108-2112 1073221375

@SGPGGA, 035216,4336.8274,N
#,07937.6647,W,8,08,2.0,19
#0.0,M,-35.4,M,,*7
1000002p 1073221453
610730.1091073221453
4829892.1911073221453
610731.0931073221453
4829892.0171073221453
610730.2971073221453
4829893.2581073221453
610731.2821073221453
4829893.0841073221453
$GPGSA,A,3,10,13,15,20,21
,24,27,32,,,,,3.6,2.0,3.0

ZHE (@ s o e o o o
SQHOQQTY

#*3

1000002 1073221609
Tu-2109-2112 1073221734
Tr-2108-2112 1073222093
Ta-2108-2112 1073222453
Ta-2109-2112 1073222812
Ta-2108-2112 1073223187
Tu-2108-2112 1073223546

@$GPGGA, 035218, 4336.8280,N
£07937.6646,W,8,08,2.0,19
#0.0,M,-35.4,M,,*7

1000003p 1073223453
{e 610730.4841073223453
{f 4829894.3241073223453
{9 610731.4701073223453
{h  4829894.1531073223453
@$GPGSA, A, 3,10,13,15,20,21
%,24,27,32,,,,,3.6,2.0,3.0

#*3

1000003 1073223609
Tu-2108-2112 1073223906
Tr-2108-2112 1073224265
Ta-2108-2112 1073224625
Ta-2108-2112 1073224984

The RTmap31 data file records are written in binary format, therefore characters may
have a different shape when displayed or printed, depending on particular video or
printer settings.
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A.3 Format of GXY Data File

The RTmap31 data file with extension GXY contains GPS records. The structure of this
file is identical to the standard RTmap31 (T31) file. The difference is that it does not
contain any EM31-MK?2 records. This file is created by RTmap31 when the EM31-MK2
option is Disabled in the System Setup menu. In this case the program acts as a GPS log-
ging program.

It should be noted that any RTmap31 data file, as well as GXY and data files created
by other Geomar data acquisition programs (RTmap38MK2, NAV31, NAV61MK2,
ML61MK2xpn, etc.) can be used as an GXY file in the data processing programs RTM
and TrackMaker for any other supported Geonics instrument (RTM31, TrackMaker31,
TrackMaker61MK2, etc.). The extension name GXY indicates that the file does not
contain electromagnetic data.
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